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InstrumentStudioInstrumentStudio  User Manual User Manual 
The InstrumentStudio User Manual provides detailed descriptions of the product 
functionality and the step-by-step processes for use. 

Looking For Something Else? 

For information not found in the User Manual for your product, such as specifications 
and API reference, browse Related Information. 

Related information: 

• Download InstrumentStudio 

InstrumentStudio User Manual
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Navigating InstrumentStudio Navigating InstrumentStudio 
Learn about the InstrumentStudio User Interface (UI) and InstrumentStudio project file 
structure so you can quickly create projects. 

Overview 
Figure 1. Example of a Scope instrument. 

The instrument controls described below are present for all instrument types in 
InstrumentStudio. 

Project File Pane 

The project file pane displays all project files, including data files, saved 
configurations, scripts, pin maps, and other supporting files. It enables critical file 
management actions like creating, renaming, deleting, importing, exporting, and 
searching for files. 

Navigating InstrumentStudio
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Table 1. InstrumentStudio Project File Documents 

Document Type Description 

InstrumentStudio project (.isproj) 
Contains the instrument panels added to your 
layout, device configurations, pin maps, 
captured data, and other project files. 

Soft front panel (.sfp) Contains the settings you choose for each 
instrument in your layout. 

Pin map (.pinmap) Defines how instruments and hardware connect 
to device under test (DUT) pins and sites. 

Technical Data Management Stream (.tdms) 
Stores data created by taking a snapshot of a 
graph. These are saved by default in the folder 
containing your project. 

Portable Network Graphic (.png) 
An image of a graph created by taking a 
snapshot. These are saved by default in the 
folder containing your project. 

Measurement Table 

The measurement table enables you to quickly set up and perform common 
measurement tasks, such as measuring signal properties, analyzing signal 
characteristics, and performing stimulus response tests. 

Navigating InstrumentStudio
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Instrument Configuration 

The instrument configuration panel enables you to configure instrument settings and 
view instrument status. 

Navigating InstrumentStudio
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Instrument Header Menu 

The instrument header menu enables you to create new instrument panels, capture 
data and screenshots, edit layouts, and export to TestStand. 

Measurement Graphs 

Measurement graphs enable you to visualize data from connected instruments, and 
interact with the graph by performing actions like zooming, panning, and creating 
annotations. 

Sequencer Tool 

Note This feature is only available with an InstrumentStudio Professional 

Navigating InstrumentStudio
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The sequencer tool enables you to create and modify measurement sequences. You 
can also view measurement panels associated with sequence steps and see a log 
detailing the results of executing a sequence. 

Related information: 

• NI TDMS File Format - What is a TDMS File? 

license. 

Navigating InstrumentStudio
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New Features and Changes New Features and Changes 
Learn about updates—including new features and behavior changes—introduced in 
each version of Package Manager. 

Related information: 

• Download InstrumentStudio 

2025 Q1 

January 2025 

Network Analyzer 

• Added support for markers. 
• Added support for memory traces. 

RF Signal Analyzer (RFmx) 

• Spectrum Analyzer - Added frequency counter measurement. 
• LTE - Added support for downlink NB-IoT. 
• Bluetooth - Added new trace and results for HDT. 

RF Signal Generator 

• Added the ability to change the active script while debugging test code in script 
mode. 

• Added the ability to switch to CW (continuous waveform) or Arb (arbitrary 
waveform) mode while debugging test code in script mode. 

Oscilloscope 

• Enhanced monitoring support- vertical scaling will be automatically updated 
based on test program settings. 

• Added support for all PXIe-5172 onboard timebase rates. 

New Features and Changes
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 Professional License Only 

The following new features are only available with an InstrumentStudio Professional 
license. 

• Sequencer Tool 
◦ Added support for native instrument types- FGEN, SCOPE, and SMU/VPS 

panels can now be added to sequences. 
◦ Added support for parameter sweeps. 

• Measurement Plug-Ins 
◦ Added support for parameter sweeps for measurement plug-ins. 

2024 Q4 

October 2024 

• Added segmented sweeps to the Network Analyzer instrument as well as 
enhancements to pulsed S-parameters, data visualizations, and calibration. 

• Added channel merging capability to the SMU/Power Supply instrument to allow 
combining multiple channels to achieve a higher output current. 

 Professional License Only 

The following new features are only available with an InstrumentStudio Professional 
license. 

• Added support for SCPI-capable oscilloscopes. 
◦ Fetch data and screenshot captures from SCPI instruments. 
◦ Fetch configurations from SCPI instruments. 
◦ Apply configurations to SCPI instruments. 
Refer to SCPI Instrument Panels for more information on using SCPI-capable 
devices with InstrumentStudio. 

• Sequencer Tool 
◦ Added support for digital multimeters in the Sequencer Tool. You can now 

create steps to read measurements from supported digital multimeters. 
◦ Added support for wait steps. You can now create wait steps in your sequences. 
◦ UI improvements to the sequencer tool. You can now view steps associated 

New Features and Changes
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with measurement panels. 
• Measurement Plug-Ins 

◦ Added support for measurement plug-in versioning. Refer to the 
Measurement Plug-In User Manual for more information measurement 
plug-in versioning. 

◦ Added support for displaying a link to measurement plug-in documentation in 
InstrumentStudio and TestStand 

Related concepts: 

• SCPI Instrument Panels 

Related information: 

• Measurement Plug-In User Manual 

2024 Q3 

July 2024 

• Pin maps are no longer required use measurement plug-ins. 
• Added several enhancements to the Network Analyzer instrument, including the 

ability to save S-parameter measurement results to Touchstone format (.snp) 
files. 

• Added band power markers to the Spectrum measurement in the RF Signal 
Analyzer instrument. 

 Professional License Only 

The following new features are only available with an InstrumentStudio Professional 
license. 

• Added support for measurement plug-ins. Refer to the Measurement Plug-Ins 
user manual for more information on developing measurements. 

• Added the Sequencer Tool for sequencing measurements using measurement 
plug-ins. 

• Added support for connecting to plug-in libraries. 

New Features and Changes
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Related concepts: 

• Sequencer Tool 

Related tasks: 

• Connecting to a Plug-In Library 

Related information: 

• Measurement Plug-In User Manual 

2024 Q2 

April 2024 

• Added manual calibration, pulse mode, triggering, and improved calset support to 
the Network Analyzer instrument. 

• Reference waveform and de-embedding file paths are now stored with the RF 
Signal Analyzer configuration, allowing for automatic reload. 

• Added several enhancements for Channel Sounding packets using the RF Signal 
Analyzer Bluetooth personality. 

2024 Q1 

January 2024 

• Added support for Fixed Markers using RF Signal Analyzer instruments. 
• Added custom bitfile support for RF Signal Analyzer and RF Signal Generator 

instruments. 

2023 Q4 

October 2023 

• You can now undo and redo changes made to panel properties. 
• Improved searching and filtering of instruments and measurements in the Edit 

Layout window. 

New Features and Changes
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• Use the new Network Analyzer instrument to control supported NI vector network 
analyzers. 

• Added support for capturing IQ data using the RF Signal Analyzer instrument. 
• Added support for Channel Sounding packets using the RF Signal Analyzer 

Bluetooth personality. 
• Added several enhancements to the RF Signal Analyzer Pulse personality, 

including support for multi-burst analysis and phase and frequency traces. 

2023 Q3 

July 2023 

• Added full support for remote RF Signal Analyzer panel for SpecAn, LTE, NR, WLAN 
and Bluetooth personalities (no longer preview features). 

• Added Bluetooth personality to remote RF Signal Analyzer panel. 
• Added new remote connections section in the preferences menu. 
• Added support for pulse measurements in the RF Signal Analyzer panel. 

Related information: 

• Remote RF Signal Analyzer Panel 
• Managing Remote Connection Preferences 

2023 Q2 

April 2023 

• Added LTE, NR, and WLAN personalities to remote RF Signal Analyzer panel 
preview feature. 

Related information: 

• Remote RF Signal Analyzer Panel 

Note Preview features have limited functionality and are not fully 
supported. 

New Features and Changes
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2023 Q1 

January 2023 

• Added SMU measurement auto-range support for PXIe-4190 and PXIe-4190 (500 
kHz). 

• Added LCR Meter impedance measurement auto-range support in sweep mode. 
• Added remote RF Signal Analyzer panel viewing as a preview feature. 

Related information: 

• SMU Measurement Autorange 
• Enabling Preview Features 
• Remote RF Signal Analyzer Panel 

2022 Q4 

October 2022 

• Added oscilloscope Manual Override mode, enabling simultaneous manual 
configuration of Record length and Sample Size in oscilloscope settings . 

Related information: 

• Setting Sample Rate and Record Length Manually 

2022 Q3 

July 2022 

• SMU measurement auto-range support for DC Power devices that support it. 
• Single-channel sweep mode support for PXIe-4190 when used in LCR mode. 
• LCR Meter mode usability improvements for PXIe-4190. 
• RF Signal Analyzer instrument with support for RFmx personalities. 

Note Preview features have limited functionality and are not fully 
supported. 

New Features and Changes
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Related information: 

• SMU Measurement Autorange 
• SMU/VPS Modes of Operation 
• Analyzing RF Signals with an RF Signal Analyzer 

2022 Q2 

April 2022 

• Single-channel sweep mode measurement added as a preview feature for 
PXIe-4190 when used in LCR mode. 

2022 Q1 

January 2022 

• LCR panel debug monitor functionality and usability improvements for the LCR 
PXIe-4190 module. 

• Custom gating support for Scope measurements. 

Related information: 

• Customizing Oscilloscope Measurements 

2021 Q4 

October 2021 

• Added new LCR panel supporting interactive use with the PXIe-4190 module. 
• Added access and visibility to pin maps. 
• Improved UI responsiveness and added pin filtering for systems with high channel 

counts. 

Related information: 

• SMU/VPS Modes of Operation 
• Setting an Active Project Pin Map 

New Features and Changes
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2021 

April 2021 

• Added new RFSG Signal Generator panel supporting interactive use and debugging 
using PXIe-5820, PXIe-5830, PXIe-5831, PXIe-5832, PXIe-5840, and PXIe-5841. 

• Added support for the PXIe-4135(40W) and PXIe-4137(40W) source measure unit, 
newly supported in NI-DCPOWER 20.7. 

Related information: 

• Generating RF Signals with an RF Signal Generator 

2020 

November 2020 

• Added support for the PXIe-4139(40W) source measure unit, newly supported in 
NI-DCPower 20.5. 

• Added support for multichannel session in the SMU/Power Supply panel, newly 
supported in NI-DCPower 20.6. Initializing an NI-DCPower session with 
independent channels allows you to use multiple instruments in the same session. 
With independent channels, you can configure multiple channels of the same 
instrument, or of multiple instruments independent of one another within the 
same session. 

• Added support for monitoring merged channels in debug mode on the PXIe-4147. 
Merged channels are newly supported in NI-DCPower 20.6. Merging channels of an 
NI SMU allows you to use multiple channels in unison to increase the current you 
can source beyond the normal maximum for a single SMU channel. 

Related information: 

• NI-DCPower Independent Channel Sessions 

2019 SP1 

May 2020 

New Features and Changes
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• Added support for the PXIe-4147 source measure unit, newly supported in NI-
DCPower 20.0. 

2019 

September 2019 

• Multiple NI-SCOPE devices of the same model can now be synchronized in the 
same oscilloscope panel. 

• Added support for selecting trigger sources and events from other NI devices in 
your system. 

• Added waveform graphing, pulse current, pulse voltage, voltage sequence, and 
current sequence modes to SMU panels, including automatic hardware 
synchronization across multiple devices. 

• Added asymmetric limits and software-protected ranges to SMU/Power Supply 
panels. 

• Added NI-DCPower SourceAdapt configuration to SMU panels, useful for transient 
measurements. 

• Added channel views to hide idle channels, show power calculations, and 
condense channel views to the SMU/Power Supply panels. 

• Added inductance and capacitance measurements along with open and short 
cable compensation to digital multimeter (DMM) panels. 

• Added the ability to generate waveforms from binary files to the waveform 
generator panel. 

• Added debugging and monitoring support to the waveform generator panel. 
• Added exporting configuration files from the waveform generator panel for use 

with the NI-FGEN driver. 
• Added capability to export device configurations to TestStand for use in test step 

configuration. 
• Added ability to use pin maps created in Digital Pattern Editor to group devices and 

channels by site and use pin names for channel aliases. 

Related information: 

• SMU/VPS Modes of Operation 
• Configuring SourceAdapt Parameters to Measure Transients 
• Performing Cable Compensation 

New Features and Changes
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• Generating Waveforms with a Waveform Generator 
• Exporting a Device Configuration 
• Exporting Configurations to TestStand 
• Pin Maps 

2018 SP2 

January 2019 

• Added support for the PXIe-5163 oscilloscope, newly supported in NI-SCOPE 18.7. 
• Added CSV file format for data capture. 
• Added support for exporting instrument events to PXI chassis trigger lines. 
• Added support for arbitrary waveform generation mode to the Waveform 

Generator panels. 
• Added support for frequency list and sweep modes to the Waveform Generator 

panels. 
• Added FFT channels, frequency markers, and FFT channel measurements to the 

Oscilloscope panels. 
• Added additional 2-channel measurements to the Oscilloscope panels. 

Related information: 

• Capturing Data 
• Waveform Modes 
• Adding FFT Channels and Markers 

2018 SP1 

September 2018 

• Added support for the PXIe-5110, PXIe-5111, and PXIe-5113 oscilloscopes, newly 
supported in NI-SCOPE 18.6. 

2018 

May 2018 

New Features and Changes
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• This was the initial release of InstrumentStudio. 
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© National Instruments 21



Supported Hardware Supported Hardware 
The following tables list hardware that can be used with InstrumentStudio, and the 
first available version of InstrumentStudio to support the hardware. 

NI-DCPower 

The following NI-DCPower hardware can be used with a SMU/Power Supply 
instrument in InstrumentStudio. 

Model Name First Available 

PXIe-4051 2023 

PXIe-4112 2018 

PXIe-4113 2018 

PXIe-4135 2018 

PXIe-4135 (40W) 2021 

PXIe-4136 2018 

PXIe-4137 2018 

PXIe-4137 (40W) 2021 

PXIe-4138 2018 

PXIe-4139 2018 

PXIe-4139 (40W) 2020 

PXIe-4140 2018 

PXIe-4141 2018 

PXIe-4142 2018 

PXIe-4143 2018 

PXIe-4144 2018 

PXIe-4145 2018 

PXIe-4147 2019 SP1 

Supported Hardware
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Model Name First Available 

PXIe-4154 2018 

PXIe-4162 2018 

PXIe-4163 2018 

PXIe-4190 1 2021 Q4 

PXIe-4190 (500 kHz) 1 2022 Q3 

PXI-4110 2018 

PXI-4130 2018 

PXI-4132 2018 

1The PXIe-4190 and PXIe-4190 (500 kHz) can be used with either an SMU/Power Supply instrument 
or an LCR meter in InstrumentStudio 

NI-DMM 

The following NI-DMM hardware can be used with a Digital Multimeter instrument in 
InstrumentStudio. 

Model Name First Available 

PXIe-4080 2018 

PXIe-4081 2018 

PXIe-4082 2018 

PXI-4065 2018 

PXI-4070 2018 

PXI-4071 2018 

PXI-4072 2018 

PCIe-4065 2018 

PCI-4065 2018 

USB-4065 2018 

Supported Hardware
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Model Name First Available 

PCI-4070 2018 

NI-FGEN 

The following NI-FGEN hardware can be used with a Waveform Generator instrument 
in InstrumentStudio. 

Model Name First Available 

PXIe-5413 (1-channel) 2018 

PXIe-5413 (2-channel) 2018 

PXIe-5423 (1-channel) 2018 

PXIe-5423 (2-channel) 2018 

PXIe-5433 (1-channel) 2018 

PXIe-5433 (2-channel) 2018 

PXIe-5442 2018 

PXIe-5450 2018 

PXIe-5451 2018 

PXI-5402 2018 

PXI-5404 2018 

PXI-5406 2018 

PXI-5412 2018 

PXI-5421 2018 

PXI-5422 2018 

PXI-5441 2018 

PCI-5402 2018 

PCI-5406 2018 

PCI-5412 2018 

PCI-5421 2018 

Supported Hardware
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NI-SCOPE 

The following NI-SCOPE hardware can be used with an Oscilloscope instrument in 
InstrumentStudio. 

Model Name First Available 

PXIe-5105 2018 

PXIe-5110 2018 

PXIe-5111 2018 

PXIe-5113 2018 

PXIe-5113 2018 

PXIe-5122 2018 

PXIe-5160 (2-channel) 2018 

PXIe-5160 (4-channel) 2018 

PXIe-5162 (2-channel) 2018 

PXIe-5162 (4-channel) 2018 

PXIe-5163 2018 SP2 

PXIe-5164 2018 

PXIe-5170 (4-channel) 2018 

PXIe-5170 (8-channel) 2018 

PXIe-5171 (8-channel) 2018 

PXIe-5172 (4-channel) 2018 

PXIe-5172 (8-channel, 325T) 2018 

PXIe-5172 (8-channel, 410T) 2018 

PXIe-5185 2018 

PXIe-5185 (1MΩ) 2018 

PXIe-5186 2018 

PXIe-5186 (1MΩ) 2018 

PXIe-5622 2018 

Supported Hardware
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Model Name First Available 

PXIe-5622 (DD) 2018 

PXI-5105 2018 

PXI-5114 2018 

PXI-5122 2018 

PXI-5124 2018 

PXI-5142 2018 

PXI-5152 2018 

PXI-5153 2018 

PXI-5154 2018 

PXI-5922 2018 

PCI-5105 2018 

PCI-5114 2018 

PCI-5122 2018 

PCI-5124 2018 

PCI-5142 2018 

PCI-5152 2018 

PCI-5153 2018 

PCI-5154 2018 

PCI-5922 2018 

PCIe-5155 2018 

USB-5132 2018 

USB-5133 2018 

NI-RFSG 

The following NI-RFSG hardware can be used with a RF Signal Generator instrument in 
InstrumentStudio. 
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Model Name First Available 

PXIe-5820 2021 

PXIe-5830 2021 

PXIe-5831 2021 

PXIe-5832 2021 

PXIe-5840 2021 

PXIe-5841 2021 

PXIe-5842 2022 

NI-RFSA 

The following NI-RFSA hardware can be used with a RF Signal Analyzer instrument in 
InstrumentStudio. 

Model Name First Available 

PXIe-5644 2022 Q3 

PXIe-5645 2022 Q3 

PXIe-5646 2022 Q3 

PXIe-5663 2022 Q3 

PXIe-5663E 2022 Q3 

PXIe-5665 2022 Q3 

PXIe-5668 2022 Q3 

PXIe-5668 with PXIe-5698 2022 Q3 

PXIe-5820 2022 Q3 

PXIe-5830 2022 Q3 

PXIe-5831 2022 Q3 

PXIe-5832 2022 Q3 

PXIe-5840 2022 Q3 

PXIe-5841 2022 Q3 
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Model Name First Available 

PXIe-5842 2022 
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Configuring Panels and Layout Configuring Panels and Layout 
Adjust the arrangement of soft front panels and their associated devices with the Edit 
Layout window. 

An InstrumentStudio layout consists of one large panel and up to four small panels. A 
large panel includes a measurement graph and is located in the center of the screen. 
Small panels feature channel settings and are located on the right sidebar. You can 
also combine multiple devices of the same type into a single panel. 

Layouts in InstrumentStudio must meet the following requirements: 

• The layout must have exactly one large panel. 
• You can place oscilloscopes only in a large panel. Only oscilloscopes of the same 

model may be added to the same panel. 
• The layout can have up to four small panels. Small panels are not required. 

Creating a Layout Creating a Layout 
Before you can take measurements and monitor devices in InstrumentStudio, you 
must create a layout. Create a layout from the Home screen, from the document 
toolbar, or from any instrument header menu. 

Creating a Layout Automatically 

When you create a layout automatically, InstrumentStudio detects devices you have 
installed and creates panels using those devices. Complete the following steps to 
create an automatic layout in InstrumentStudio: 

Note You can edit an automatic layout at any time by choosing Add/Remove 
devices from the instrument header menu. Opening the Edit Layout window 
using Add/Remove devices automatically filters the device list based on the 
type of panel you selected Add/Remove devices from. Remove or change the 
filter using the drop-down menu in the upper left corner. 
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1. Install the devices you would like to use and make sure they appear in 
Measurement & Automation Explorer (MAX). 

2. Open InstrumentStudio. 
3. Select Auto Create Layout from the Home screen. 

InstrumentStudio creates a large or small panel for each compatible device installed in 
the system. 

Creating a Layout Manually 

You can use the Edit Layout window to create a manual layout. In a manual layout, you 
can customize which devices are displayed and group devices of the same type into a 
single panel. 

Refer to Configuring Panels and Layout to learn more about layout rules and 
restrictions. 

Complete the following steps to create or edit a manual layout: 

1. Access the Edit Layout window in one of three ways: 
◦ From the Home screen, select Manual Layout. 
◦ From any instrument header menu, select Add/Remove devices. 

◦ From the document toolbar, select the Edit layout icon ( ). 
2. Search for the device(s) you would like to include in the layout in the left panel of 

the Edit Layout window. You can filter by device type using the drop-down menu in 
the upper left corner. 

3. Add the device to a panel by selecting either Create large panel or Create small 
panel from the device's drop-down menu. 
The device is displayed in the panel you select. 

Note 
▪ Opening the Edit Layout window using Add/Remove devices 

automatically filters the device list based on the type of panel 
you selected Add/Remove devices from. Remove or change the 
filter using the drop-down menu in the upper left corner. 

▪ Only oscilloscopes of the same model may be added to the 
same panel. 
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4. (Optional) Once a panel is created, you can group devices of the same type 
together in a single panel by selecting the group name from a device's drop-down 
menu. 

5. Select OK to create the layout you specified. 

You have created a manual layout. 
Related concepts: 

• Configuring Panels with the Instrument Header Menu 

Configuring Panels with the Instrument Header Menu Configuring Panels with the Instrument Header Menu 
You can use the instrument header menu to remove devices, export panels to a new 
tab, relink missing devices, and more. 

Each panel in InstrumentStudio has its own instrument header menu, which you can 
access by clicking the instrument header menu icon in the upper-right corner of the 
panel. Within the instrument header menu( ), you can select the following options: 

• Capture data—Saves a timestamped screenshot and an NI-TDMS file containing a 
data snapshot. Refer to Capturing Data for more information. 

• Export configuration—Saves model-specific configuration files to a specified 
folder. You can import a configuration file to LabVIEW to apply the device's 
configuration to a different device session. Refer to Exporting a Device 
Configuration for more information. 

• [Device name]—Opens options for the specified device. From this menu, you can 
remove the device from the panel, relink devices, and access the device's 
documentation. 

• Add/Remove devices—Opens the Edit Layout window. Refer to Creating a Layout 
for more information on the Edit Layout window. 

• Configure debug session—Opens the Configure Debug Session window, which you 
can use to enable and disable debugging on devices. Refer to Debugging 
Programmatic Applications for more information. 

• Launch in new tab—Opens the panel in a new tab with the same configuration. 

Note You can remove a device from a panel by clicking the × to the right 
of the device's name. 
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• Delete panel—Removes the panel from the layout. 

Related concepts: 

• Capturing Data 
• Debugging Programmatic Applications 

Related tasks: 

• Creating a Layout Manually 
• Enabling Debugging with a C, C++, or .NET Application 
• Exporting a Device Configuration 
• Relinking or Replacing Missing Devices 

Relinking or Replacing Missing Devices Relinking or Replacing Missing Devices 
Use relinking to re-establish a connection to a missing device, or replace the missing 
device with a different device of the same model in an existing panel. 

If InstrumentStudio is closed and a device used in an InstrumentStudio project goes 
offline or has its name changed, InstrumentStudio flags that device as missing the next 
time you open the project. The panel's title bar is gray instead of blue and displays a 
"Missing hardware" message. The caution icon ( ) appears over the instrument 
header menu of the affected panel and next to the missing device inside the 
instrument header menu. InstrumentStudio also notifies you of the missing device in 
the Edit Layout window. 

Relink a missing device through the instrument header menu, or replace a missing 
device in the Edit Layout window. When you relink a missing device through the 
instrument header menu, InstrumentStudio applies the missing device's existing 
configuration to the relinked device. When you replace a missing device through the 
Edit Layout window, InstrumentStudio discards the existing device configuration and 
creates a new one for the replacement device. 

Note You can also relink or locate a missing device through Measurement & 
Automation Explorer (MAX). If InstrumentStudio is open, changes made in 
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Relinking Missing Devices from the Instrument Header Menu 

1. Open the instrument header menu of the panel ( ) with the missing device. 
2. Select the missing device. The missing device has a caution icon ( ) next to it. 
3. Select Relink. 
4. Select the name of the device to link to the panel. 

5. Select Run on the relinked panel. 

You relinked the missing device (or a device of the same model) to the panel. 

Replacing Missing Devices from the Edit Layout Window 

You cannot directly relink a missing device from the Edit Layout window, but you can 
remove a missing device and replace it with a different device by completing the 
following steps: 

1. Open the Edit Layout window in one of two ways: 
◦ From the document toolbar, select the Edit layout icon ( ). 
◦ From any instrument header menu, select Add/Remove devices. 

MAX are automatically applied to InstrumentStudio panels. If a device went 
missing because it was renamed while InstrumentStudio was closed, relink 
the missing device by changing the device's name in MAX to match the name 
InstrumentStudio is looking for while the InstrumentStudio panel that 
contains the missing device is open. 

Note You can also use this method to link a different device of the same 
model to an existing panel, even if the original device is not missing. 
Replacing a device in a panel via relinking preserves device settings from the 
original device and applies them to the replacement device. 

Note When relinking from the instrument header menu, the relinked 
device must be the same model as the missing device. InstrumentStudio 
applies the existing device configuration to the new device when it is 
linked. 
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2. Locate the missing device. The missing device has a caution icon ( ) next to it. 
3. Select the × next to the caution icon to remove the missing device from the layout. 

4. Add a replacement device of the same type to the panel (if adding to a group), or 
make a new panel with the replacement device. 

5. Select OK to save your changes. 
6. Select Run on the edited panel. 

Related concepts: 

• Configuring Panels with the Instrument Header Menu 

Multi-Device Synchronization Multi-Device Synchronization 
In InstrumentStudio, device synchronization generally falls under two categories: 
software and hardware. 

Software Synchronization Hardware Synchronization 

Channel acquisition and generation is 
sequenced in software. 

Channel acquisition and generation is 
sequenced in hardware. 

Note Opening the Edit Layout window using Add/Remove devices 
automatically filters the device list based on the type of panel you 
selected Add/Remove devices from. For best results, select Add/
Remove devices from the panel that contains the device you want to 
replace. 

Note If the missing device was not part of a group, removing the device 
also removes the device's panel. 

Note When replacing missing devices from the Edit Layout window, the 
new device must follow the same InstrumentStudio layout guidelines as 
any other device. Refer to Configuring Panels and Layout for more 
information on layout guidelines. 
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Software Synchronization Hardware Synchronization 

There is no strict timing guarantee between 
channels. 

There is a strict timing guarantee between 
channels. 

Panel Synchronization 

The different panels within InstrumentStudio support various levels of device and 
channel synchronization: 

DMM—All channels are always software synchronized. 

Waveform generators—All channels are software synchronized by default. 

• All channels on a single device are always hardware synchronized. 
• All channels within a single panel are hardware synchronized if every device is the 

same model and is in the same chassis. Channels across different physical devices 
are synchronized with NI-TClk technology. 

• You can also trigger an oscilloscope from another instrument in the system by 
configuring a digital trigger and selecting the source based on the device name. 

• Every channel configured for a sequence or pulse generation within a single SFP 
are automatically hardware synchronized. You can configure routing options by 
selecting the  icon. 

• Channels are software synchronized ( ) in all other cases. 
• You can also trigger an SMU from another instrument in the system by configuring 

a digital trigger and selecting the source based on the device name. 

The following details apply to RFSG, RFSA, and Network Analyzer instruments. 

• You can only have one device in a single panel. 
• Devices cannot be synchronized. 

Note Channels within a 2-channel PXIe-5450 or PXIe-5451 waveform 
generator are always hardware synchronized. 
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Remote RF Signal Analyzer Panel Remote RF Signal Analyzer Panel 
This section describes how to add a remote RF Signal Analyzer to your project to use 
remote RFmx hardware. 

The following list describes important limitations to be aware of while using remote RF 
panels. 

• Spectrum Analyzer, LTE, WLAN, Bluetooth, and NR personality are the only 
available personalities in remote Signal Analyzer panels. 

• Remote hardware must be present on the same network in order to be remotely 
connected. 

• Remote panels perform best when the remote hardware is within your local facility 
topology. 

• You cannot create a remote panel for a device that is in use by another remote 
client. 

• You cannot remotely monitor a remote session hosted on another client. 

Overview of Remote Panel Connections 

Remote panel connections are facilitated by the NI gRPC server. You do not need to 
install NI drivers on the client you use to remotely access an RF panel. All required 
drivers must be installed on the server which hosts the hardware. 
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Figure 2. gRPC Server-Client Architecture 

Refer to Configuring Your System for Remote RF Signal Analyzer Panels for 
more information 

• Adding a Remote RFmx Panel to Your Layout 
• Configuring Your System for Remote RF Signal Analyzer Panels 

Configuring Your System for Remote RF Signal Analyzer Panels Configuring Your System for Remote RF Signal Analyzer Panels 

You must configure a gRPC server before remotely connecting to RF Signal Analyzer 
hardware using InstrumentStudio. The server must be set up on the computer that is 
connected to the hardware. Complete the following steps to enable remote 
connections to RF Signal Analyzer hardware. 

1. Go to the NI gRPC device repo and follow the instructions there to install the NI 
gRPC server on the computer connected to the hardware. 

2. Navigate to the install location, and open the server_config.json file in an 
editor. 

3. Add the following parameter and value to your configuration file: 
"code_readiness": "RestrictedRelease" 

4. Remove the line "address" : "[::1]". This allows any address to connect to 
the device. 

5. Update the port number. This will require users to specify a port number when 
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connecting from InstrumentStudio. 
6. Run the server. Follow instructions in the NI gRPC device repo for specific 

instructions on running the server. 

Your configuration file should now look like this: 
{ 

  "port": 31763, 

  "security" : { 

     "server_cert": "", 

     "server_key": "", 

     "root_cert": "" 

  }, 

  "code_readiness": "RestrictedRelease" 

} 

Your system is now configured to allow clients to create remote Signal Analyzer panels 
in InstrumentStudio. 

Adding a Remote RFmx Panel to Your Layout Adding a Remote RFmx Panel to Your Layout 

Complete the following steps to view RFmx hardware measurements remotely using 
an InstrumentStudio panel. 

Before you can view RFmx hardware measurements remotely, you must configure your 
system. 

1. Enable the remote RFmx panel feature in InstrumentStudio settings. 
2. Click Add remote host connection. 
3. Select Remote Instrument as the Host type. 
4. Enter the IP address or hostname and the port number of the server you want to 

connect to. 
5. Click OK to add a panel for the remote device to your layout. 
6. Continue setting up your layout as needed. 

After adding the panel to your layout, the device name will appear as follows: Device 
Name-Model Number(Remote). 
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Related information: 

• Configuring Your System for Remote RF Signal Analyzer Panels 

Managing Remote Connection Preferences 

1. Go to File » Preferences » Remote connections. 
2. Choose from the following options to manage remote connections: 

Option Description 

Remove a Connection Right-click Remove device. 

Select a Default Device Right-click a device from the available device 
list and select Make default device. 
InstrumentStudio will use this device when 
creating auto-layouts. 

SCPI Instrument Panels SCPI Instrument Panels 
You can create instrument panels using SCPI-capable devices the same way you create 
instrument panels for native NI hardware. SCPI instrument panels do not include all of 
the capabilities present in native NI instruments. These panels are primarily intended 
to use as companions to third-party hardware, and can perform essential tasks like 
fetching data, screenshots, and SCPI configuration. Refer to the following sections for 
more information on adding SCPI instrument panels to your project. 

Connecting to SCPI-Capable Devices using NI-VISA 

Before InstrumentStudio can detect your SCPI-capable device, you must first connect 
the device to your system using Hardware Configuration Utility or NI MAX. Refer to the 
Hardware Configuration Utility User Manual or Measurement and 
Automation Explorer User Manual for information on connecting VISA devices. 

Note You must take over a device session to interact with a device in control 
mode. You can only view panels in debug mode when the session is running 
locally on the device. 
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Adding SCPI Instrument Panels to a Project 

You can add SCPI instrument panels to a project by selecting Manual Layout from the 
Home screen. Search for the device(s) you would like to include in the layout in the left 
panel of the Edit Layout window under Instruments » VISA Instruments 

Additional Setup for SCPI Instrument Panels 

Some SCPI instrument panels require additional set up to ensure use with 
InstrumentStudio. 

Refer to the following section for more information on how to perform additional set 
up for SCPI-capable devices. 

Configuring a SCPI-Capable Device 

SCPI-capable devices are supported for use in InstrumentStudio, but most devices will 
require additional configuration. Complete the following steps to configure a SCPI 
instrument and add it to your InstrumentStudio project. 

1. Add your instrument to your system using either Hardware Configuration Utility or 
Measurement and Automation Explorer (MAX). 

2. In InstrumentStudio, go to Manual layout. 
3. Find your instrument and add it to a panel. 
4. When attempting to create a SCPI instrument panel that requires additional set up, 

you will be prompted to set up the panel. Click the appropriate button to proceed. 
A file explorer window will open at the location of a new JSON configuration file 
that will be associated with the selected SCPI-capable device. 

5. Open the new JSON file. 
6. Read through the comments included in the JSON file to understand what each 

section of the template does, and how to modify them for your instrument. For 
example, make sure the Channels section matches the number of available 
channels on your device. If you are setting up a 2-channel instrument, you would 

Tip Look for devices named Unknown Instrument when selecting a SCPI-
capable device from the Manual Layout window. This indicates that the 
device was successfully discovered by InstrumentStudio, but requires further 
set up. 
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remove the last two channels from this list. 
// List of all channels available on the instrument. 

  "Channels": [ 

    { 

      "DisplayName": "Channel 1", 

      "ScpiName": "CHAN1" 

    }, 

    { 

      "DisplayName": "Channel 2", 

      "ScpiName": "CHAN2" 

    }, 

    { 

      "DisplayName": "Channel 3", 

      "ScpiName": "CHAN4" 

    }, 

    { 

      "DisplayName": "Channel 4", 

      "ScpiName": "CHAN4" 

    }, 

  ], 

7. Save and close the file. 

8. Open the instrument header menu ( ) and select Refresh panel. 

Refer to Additional Information About SCPI Instruments for more information 
on configuring SCPI instruments. Refer to Using SCPI Instruments for information 
on fetching data and configuration settings from SCPI instruments. 

Additional Information About SCPI Instruments 

The following sections provide additional details about SCPI instrument support in 
InstrumentStudio. 

Supported SCPI Instrument Types Supported SCPI Instrument Types 

InstrumentStudio supports the use of SCPI-capable oscilloscopes, SMUs, and DMMs. 
Generic support is available for other device types. 

Warning Do not change the name of the file, or move it from the folder 
it was created in. 
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SCPI-Capable Device Vendors SCPI-Capable Device Vendors 

NI has tested SCPI-capable instruments from the following vendors: 

• Agilent 
• Keysight 
• Tektronix 
• Fluke 
• Keithley 

Configuration files are installed with InstrumentStudio for each of the vendors listed 
above. 

SCPI-Capable Devices from Other Vendors SCPI-Capable Devices from Other Vendors 

A generic configuration file is installed with InstrumentStudio to support SCPI-capable 
devices from other vendors. When you add one of these devices to a panel, a new 
JSON configuration file is generated. This file may require modification. Refer to the 
notes in the JSON template files for specific instructions. 

Examples and Templates Examples and Templates 

A collection of configuration file examples and templates is installed with 
InstrumentStudio. Go to %PROGRAMFILES%\National Instruments\
Shared\Services\Scpi\ScriptDefinitions\Examples to view these. The 
examples provide additional details about different script types and associated device 
commands to help you configure your SCPI instrument. 

Note Although exhaustive testing of third-party SCPI-capable devices is not 
possible, the included configuration files typically work for all devices from a 
vendor. 

Note NI cannot guarantee all SCPI-capable devices for other vendors will 
work as expected in InstrumentStudio. Refer to the documentation for your 
device for more details on its SCPI command set. 

Note Other product and company names listed are trademarks or trade 
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Using SCPI Instruments Using SCPI Instruments 

The following sections contain instructions for performing common tasks using SCPI 
instruments. 

Fetching Data From a SCPI Instrument 

Complete the following steps to fetch data from a SCPI instrument. 

InstrumentStudio fetches data from the last time a SCPI instrument performed a 
measurement. Fetching SCPI instrument data does not trigger acquisition. 

1. Select the data you want to capture using the checkboxes in the instrument panel. 
◦ Channels— select specific channels to fetch data from. This option sends a 

SetChannel SCPI command to the device. 

◦ Include screen image— fetches an image of your SCPI instrument screen. The 
fetched image will either be a .png or .bmp, depending on the device. 

2. Click Fetch Data to fetch the data from the selected sources. 

To fetch new data, trigger data collection on your SCPI instrument and repeat this 
process. 

SCPI Instrument Configuration Management 

When you make changes to your device, such as turning a setting knob or pressing a 
button, the configuration settings for the device change and are stored in the device. If 
you have a preferred configuration to perform a specific task, you can fetch and store 
these settings in your SCPI instrument panel for later use. The following sections 
describe how to manage configuration settings within your project. 

names of their respective companies. 

Important You must select at least one channel to fetch data. 

Note You can also capture this data using Capture Data and Capture 
Screenshot. 
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Fetch Existing Configuration Settings 

To fetch configuration settings from a device, click  to open the instrument 
configuration utility. Click the Fetch Configuration tab, then click Fetch to fetch the 
device configuration settings. The settings will appear in the configuration utility 
window. To store the fetched configuration data to the selected panel, save your 
InstrumentStudio project. 

Applying Configuration Setting 

To apply device settings stored in a SCPI panel, open the instrument configuration 
utility ( ), click the Fetch Configuration tab, and click Apply. 

Sending Commands to a SCPI Device 

Complete the following steps to send SCPI commands to your SCPI-capable devices 
using a SCPI instrument panel. 

1. Click  to open the instrument configuration utility. 
2. Click the Send Command tab. 
3. Click Send Command to open the command editor. 
4. Enter the command you want to send to your SCPI-capable device in the textbox. 

5. Click Send to send the command to your device. 

Note Refer to your device user manual for more information on 
supported SCPI commands. 

Configuring Panels and Layout

44 ni.com



Digital Multimeters Digital Multimeters 
Refer to the following sections for information about setting up a digital multimeter 
instrument in InstrumentStudio. 

Auto Range Modes 
When specifying a range for a voltage or current measurement, you can select Auto or 
Auto once to measure a signal when you do not know which range to select. The 
digital multimeter (DMM) takes a series of measurements and adjusts the range until 
the measurement falls within the smallest range appropriate for that measurement. 

• Auto—Takes a reading before each measurement to select the smallest 
appropriate range. 

• Auto once—The first point measured determines the range for the rest of the 
measurements. 

Performing Cable Compensation 

Typically, you connect the digital multimeter (DMM) to a device under test with 
switches, fixtures, or cables. These switches and fixtures can introduce undesired 
errors into the measurement. Open and short cable compensation minimizes these 
measurement errors when taking capacitance or inductance measurements. 

Compensation consists of measuring the error and applying the measured error to the 
actual measurement to correct and minimize the errors introduced by the test system. 
The compensation values must be renewed before taking a measurement at a 
specified function and range. Any change in range or function defaults the 
compensation type to none, and you must perform compensation again for accurate 
measurements. 

Note For model-specific considerations when using Auto Range, refer to 
Configuring Auto Range in NI-DMM documentation. 
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Performing Open Compensation for Capacitance and Inductance 
Measurements 

1. Disconnect the device under test (DUT) from the DMM at the connection point on 
the DUT. Leave the cable connected to the DMM. 

2. Configure the DMM for capacitance or inductance at the desired range. 
3. Open the settings ( ) for the DMM channel. 
4. Click Renew under the Open cable compensation section of the settings window. 

5. Click Continue in the Open Cable Compensation dialog box. 

Performing Short Compensation for Capacitance and Inductance 
Measurements 

1. Disconnect the DUT from the DMM at the connection point on the DUT. Leave the 
cable connected to the DMM. 

2. Configure the DMM for capacitance or inductance at the desired range. 
3. Set up a short condition using a low-impedance connection between the HI and LO 

terminals of the DMM. Cables and switches with low capacitance and low path 
resistance are recommended. 

4. Open the settings ( ) for the DMM channel. 
5. Click Renew under the Short cable compensation section of the settings window. 

6. Click Continue in the Short Cable Compensation dialog box. 

Note These settings are not available for simulated DMM devices. 

Note Check the device panel to make sure compensation has been 
applied ( ). 

Note These settings are not available for simulated DMM devices. 

Note Check the device panel to make sure compensation has been 
applied ( ). 
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LCR Devices LCR Devices 
Refer to the following sections for information about setting up an LCR instrument in 
InstrumentStudio. 

Calibrating an LCR Device 

Self-calibrate an LCR device to ensure accurate measurements. 

The accuracy of a device will naturally drift over time. Self-calibration ensures more 
accurate measurements by compensating for board level temperature variations and 
device degradation, as well as ensuring that the device operates within ranges defined 
in your test specifications. 

1. In the LCR device instrument pane, open the instrument header menu ( ). 
2. Click Device Slot » Calibration . 
3. Click Self-calibrate in MAX to proceed to self-calibration in MAX. 

Refer to When to Calibrate an LCR Device for information on how often to calibrate 
your LCR device. 

• Performing Compensation on an LCR Device 

When to Calibrate an LCR Device 

Performing regular LCR device calibration ensures better accuracy in your test 
measurements. 

Performing new LCR device self-calibration is recommended if any of the following 
occur. 

• You are installing the module in a chassis for the first time. 
• You install, uninstall, or move another module in the same chassis as your LCR 

device. 
• The ambient temperature in your test environment has changed significantly. 
• The onboard temperature of the LCR device has drifted significantly (+/- 5° C) since 

the last self-calibration. 
• 24 hours have elapsed since the previous self-calibration. 
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Performing Compensation on an LCR Device 

Typically, you connect the LCR device to a device under test with switches, fixtures, or 
cables. These introduce undesired errors into the measurement. Prevent 
measurement errors from switches, fixtures, or cables by applying compensation 
before taking measurements. 

Perform the following steps to apply compensation to your LCR device. 

1. Calibrate the LCR device. 
2. Determine the type of cable compensation you want to perform. Click the option 

link for detailed instructions on performing the selected compensation. 

Option Recommended When 

Standard cable compensation You are using a standard NI cable that is 
represented with a Cable Length profile in the 
Instrument Settings dialog ( ) and your test 
setup is simple—it excludes complex circuitry, 
like switches, that could affect LCR 
measurements. 

Custom cable compensation You are using non-NI cabling and your test 
setup includes complex circuitry like switches 
that could affect LCR measurements. 

3. Determine the type of LCR compensation you want to perform using the following 

Note For detailed driver documentation on performing LCR device 
compensation, refer to Compensation of LCR Measurements with NI-
DCPower. 

Note NI recommends applying cable compensation for low-level LCR 
measurements where the effects of cabling may be significant relative to 
the quantity you are measuring. 

Note NI recommends first applying short LCR compensation when using 
custom non-NI cabling to ensure accurate measurements. 
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criteria. Click the option link for detailed instructions on performing the selected 
compensation. 

Option Recommended When 

Open LCR compensation Stray admittance in your test setup influences 
LCR measurements. 

Short LCR compensation The impedance of your DUT is low (<100Ω) 
and the residual impedance of cabling and 
fixtures may be a significant percentage of 
your DUT impedance. 

Load LCR compensation The reference load value is similar to your DUT 
and your test setup includes complex circuitry 
like switches that can affect LCR 
measurements. 

NI recommends performing cable and LCR device compensation after making changes 
to your test system set up or performing new LCR device calibration. Refer to When to 
Generate New Data for Custom Cable Compensation or LCR Compensation for more 
information on when to perform new compensations. 

Applying Standard Cable Compensation 

1. Click Instrument Settings ( ) in your LCR device instrument panel. 
2. Select your cable length from the Cable type drop-down. 

Performing Custom Cable Compensation 

Disconnect the device under test (DUT) from the LCR device at the connection point on 
the DUT. Leave the custom cables connected to the LCR device. 

Note Such stray admittance is 
present in most test setups. 

Note Open and short LCR compensations are prerequisites to 
performing load LCR compensation. 
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1. Click Custom Compensation ( ) in the instrument panel. 
2. Click Renew. 
3. Click Compensate. 
4. Click OK. 

Verify that your device is configured for custom cables by opening Instrument Settings 
( ) and selecting "Custom " from the Cable type dropdown. 

Verify compensation is applied. Click Custom Compensation ( ) and check that Apply 
compensation is enabled. 

Performing LCR Load Compensation 

Connect a reference load to the fixture that will contain your DUT. 
Figure 3. Load Configuration Diagram. 

Refer to the diagram below when setting up a load configuration for LCR load 
compensation 

Note The connection point may be a switch, fixture, or any other circuit used 
to connect LCR device cabling to the DUT. When performing custom cable 
compensation, only the custom cables should be connected to the LCR 
device. 

Note For detailed driver documentation on performing LCR device 
compensation, refer to Compensation of LCR Measurements with NI-
DCPower. 
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1. Click Load Compensation ( ) in the instrument panel to open the compensation 
dialog. 

2. Click Renew. 
3. Optional: Enter spots to compensate for. 
4. Click Compensate. 
5. Click OK. 

To verify compensation is applied, click Load Compensation ( ) and check that Apply 
compensation is enabled. 

Performing Open LCR Compensation 

Disconnect the device under test (DUT) from the LCR instrument at the connection 

Note For detailed driver documentation on performing LCR device 
compensation, refer to Compensation of LCR Measurements with NI-
DCPower. 
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point on the DUT. Leave the cabling connected to the LCR device, and any other test 
system components such as switches and DUT fixtures. 
Figure 4. Open Configuration Diagram. 

Refer to the diagram below when setting up an open configuration for LCR open 
compensation 

1

2

3

4

5

5

5

1. HI CUR 
2. HI POT 
3. LO POT 
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5. Connection between outer conductors 

1. Click Open Compensation ( ) in the instrument panel to open the compensation 
dialog. 

2. Click Renew. 
3. Optional: Enter additional frequencies to compensate for. 
4. Click Compensate. 
5. Click OK. 

To verify compensation is applied, click Open Compensation ( ) and check that Apply 
compensation is enabled. 
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Performing Short LCR Compensation 

Disconnect the device under test (DUT) from the LCR device at the connection point on 
the DUT. Leave cabling, switches, and DUT fixtures connected to the LCR device. 
Figure 5. Short Configuration Diagram. 

Refer to the diagram below when setting up a short configuration LCR short 
compensation 
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1. Click Short Compensation ( ) in the instrument panel to open the compensation 
dialog. 

2. Click Renew. 
3. Optional: Enter additional frequencies to compensate for. 
4. Click Compensate. 

Note For detailed driver documentation on performing LCR device 
compensation, refer to Compensation of LCR Measurements with NI-
DCPower. 
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5. Click OK. 

To verify compensation is applied, click Short Compensation ( ) and check that 
Apply compensation is enabled. 

When to Generate New Data for Custom Cable Compensation or LCR Compensation 

Performing new custom cable and LCR device compensation ensures better accuracy 
in test measurements after making changes to your test system setup. 

Generate new custom cable compensation data or LCR compensation data if any of the 
following occur. 

• You perform a new external calibration 
• You perform a new self-calibration 
• You add complex circuit elements, such as a switch, between the end of the cable 

and the fixture containing your DUT 
• You change the length of the cabling in your test setup 
• You change the physical orientation of the cabling in your test setup 
• You begin testing a DUT that is different (on the basis of part number) from the 

DUT for which you originally generated compensation data; 

Oscilloscopes Oscilloscopes 
Refer to the following sections for information about setting up an oscilloscope 

Note You must perform short LCR compensation when using custom 
non-NI cabling. Complete custom cable compensation before performing 
short LCR compensation. 

Note For detailed driver documentation on performing LCR device 
compensation, refer to Compensation of LCR Measurements with NI-
DCPower. 

Note For load LCR compensation, choose a new reference load 
appropriate for the new DUT. 
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instrument in InstrumentStudio. 

Oscilloscope Setup Actions 

You can configure the setup of an oscilloscope using two options: Auto setup and 
Default setup. 

• Default setup—Returns the device to the default configuration. 
• Auto setup—Enables all channels and automatically configures device settings. 

Settings Changed by Auto Setup 

Setting an oscilloscope to Auto setup changes the following settings: 

General Settings Value 

Acquisition Mode Normal 

Reference Clock Internal 

Vertical Settings Value 

Vertical Coupling Unchanged by Auto Setup. 

Vertical Bandwidth Full 

Vertical Range Changed by Auto Setup.1[1] 

Vertical Offset 0 V 

Probe Attenuation Unchanged by Auto Setup. 

Input Impedance Unchanged by Auto Setup. 

Horizontal Settings Value 

Sample Rate Changed by Auto Setup.[1] 

Min Record Length Changed by Auto Setup.[1] 

Enforce Realtime True 

Number of Records 1 

1. Auto Setup adjusts this setting to different values depending on the signal. 
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Triggering Settings Value 

Trigger Type Edge if signal present, otherwise immediate. 

Trigger Channel Lowest numbered channel with a signal present. 

Trigger Slope Positive 

Trigger Coupling DC 

Reference Position 50% 

Trigger Level 50% of signal on trigger channel. 

Trigger Delay 0 

Trigger Holdoff 0 

Trigger Output None 

Setting Sample Rate and Record Length Manually 

By default, InstrumentStudio optimizes either the record length or sample rate of an 
oscilloscope when taking measurements. When the thumbnail preview is enabled with 
Data Display set to Live, InstrumentStudio limits the maximum record length to 1 
million samples. When set to On demand, InstrumentStudio increases the maximum 
record length to 10 million samples. To configure larger records, use Manual Override 
mode. Enable Manual Override mode to manually configure both Sample rate and 
Record length settings for an oscilloscope. 

Complete the following steps to enable Manual Override mode. 

1. Click Instrument Settings ( ) in your oscilloscope device instrument panel. 
2. Click the Manual Override mode toggle. 

The toggle should be in the On position after clicking. 
3. Enter the desired values for Sample Rate and Record Length. 

Note NI recommends that you only enable Manual Override for test 
parameters that require specific sample rate and record length values. 
Otherwise, NI recommends leaving this setting off for the best interactive 
experience with an oscilloscope. 
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Acquisition Status 

You can determine the current state of an acquisition by looking at the acquisition 
status icon, located in the Horizontal & Acq. header of an oscilloscope panel. 

• Triggered—The device met the trigger condition and performed an acquisition 
based on the specified trigger settings. 

• Auto—After a certain amount of time has passed without a trigger firing, the device 
automatically triggers an acquisition. The Auto status displays briefly when this 
occurs. 

• Waiting—The device is waiting to take an acquisition until the trigger condition has 
been met. 

• Stopped—The instrument is not running. 

Interpolation Method 
You can set the interpolation method of an oscilloscope acquisition to one of the 
following settings from the Instrument Settings window: 

• No interpolation—The oscilloscope does not interpolate data. 
• Auto—The oscilloscope interpolates data when the visible time per division is too 

small for acquisitions performed at the maximum sample rate. If you set the 
sample rate of the oscilloscope to Manual, the oscilloscope treats the sample rate 

Note Enabling Manual Override mode may lead to unexpected graph 
behavior if Sample rate and Record length are improperly configured. For 
example, if your device does not have enough onboard memory to 
accommodate measurement settings, your graphs may not render properly, 
or you may get an error message in InstrumentStudio. Other settings may 
either cause data to be unreadable, or take longer than expected to appear. 
For example, if you enter a Sample rate of 1 kS/s with a Record length of 3.5 
MS, it would take around an hour before the measurement data appeared in 
your oscilloscope panel in InstrumentStudio. 

Note The trigger mode must be set to Auto to enable automatic 
triggering. 
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you enter as the maximum sample rate. The Auto interpolation method takes 
headroom into account when determining whether or not to perform 
interpolation; if there is low headroom between the oscilloscope's bandwidth and 
its sample rate, the oscilloscope does not interpolate the data. 

• On—The oscilloscope interpolates data as often as possible without taking 
headroom into account. If you set the interpolation method to On, the oscilloscope 
will interpolate data in all cases except for the following: 
◦ The oscilloscope's sampling method is set to Random Interleaved Sampling 

(RIS). 
◦ The acquisition uses the peak detect sample mode. 
◦ The waveform has enough data and does not need interpolation. 

Sampling Methods 
Depending on the device, you can select different sampling methods from the 
Instrument Settings window of an oscilloscope: 

• Real time—Gathers all the samples for a waveform in one acquisition with one 
trigger event. 

• RIS—Random Interleaved Sampling (RIS) achieves a higher synthetic sample rate 
by combining several triggered waveforms. 

Sample Modes 
You can select one of the following sample modes from the Instrument Settings 
window when configuring an oscilloscope acquisition with InstrumentStudio: 

• Sample—The oscilloscope measures the signal at a fixed time interval (the sample 
rate). 

• Peak detect—The oscilloscope internally samples the signal at its maximum 
sample rate, then saves the maximum and minimum value of the input signal 
within the configured sample interval. Use Peak detect when you would like to 
acquire measurements for a longer time while still being able to detect transients. 

• Averaging—The oscilloscope averages the waveform data of continuous 

Note RIS is not supported on all oscilloscopes. You can select RIS only 
with supported devices. Refer to your device's documentation to 
determine whether or not it supports RIS. 

Configuring Panels and Layout

58 ni.com



acquisitions based on the averaging count. The oscilloscope performs an 
exponential moving average and shows the number of averages, which shows how 
many waveforms have been read and averaged. 

Adding FFT Channels and Markers 

Use FFT channels with an oscilloscope to measure amplitude and frequency of a 
sample. You can also fetch more detailed measurements and search for peaks using 
markers. 

Creating FFT Channels 

1. From a large oscilloscope panel, click the FFT button in the Add Channels section. 
A frequency graph displays. 

2. Select a Source for the FFT channel. You can select any single existing channel. 
3. Select a Window function for the FFT channel. 
4. (Optional) Configure additional settings for the FFT channel by clicking the FFT 

channel's settings cog. Refer to Searching For and Computing Peaks for more 
information. 

Creating Markers 

A marker fetches the amplitude (y-location) of a particular sample at a specified 
frequency (x-location) of a particular sample. Complete the following steps to create a 
marker or markers: 

1. After creating an FFT channel, select the Markers drop-down in the frequency 
graph header. Select Markers: On to enable markers and open the marker toolbar. 

2. From the marker toolbar, select a marker to configure. By default, only Marker 0 is 
enabled. 

3. Select the FFT channel the selected marker should measure. 
4. Enter the frequency where you want to place the marker. The amplitude of the 

signal at the frequency of the marker is displayed in the Level section of the 

Note Enable more markers by selecting a marker from the marker 
toolbar and changing the marker mode from Off to Normal. You can 
enable up to 12 markers. 
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marker toolbar. 

Searching For and Computing Peaks 

After enabling at least one FFT channel and markers, you can use the peak search 
functions to locate peaks. Peaks are the samples for which the amplitude rises and 
falls around a threshold. You can move the selected marker to the highest peak, the 
next highest peak, or an adjacent peak to the left or right of the marker. You can 
configure the peak threshold and excursion settings by selecting the cog icon next to 
the peak search functions. 

Computing Peaks Using Peak Threshold and Excursion Computing Peaks Using Peak Threshold and Excursion 

The peak threshold is the minimum amplitude level a sample must rise above to be 
considered a peak. If peak threshold is enabled but peak excursion is not, every 
amplitude measurement above the threshold is considered a peak. Set the peak 
threshold from the peak search settings. 

Peak excursion specifies the minimum amplitude variation required in a signal to be 
considered as a peak. Peak excursion is always specified with respect to a threshold 
value. A signal must rise and fall above the threshold level by at least the peak 
excursion value to be considered as an eligible peak. 

The following figure shows how to identify a valid peak that meets excursion criteria: 

Note You can view and edit the frequency of all enabled markers in the 
Markers table below the frequency graph. The Markers table also displays 
the markers' current level, mode, and source channel. 
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Peak 1 rises and falls by at least the peak excursion value above the threshold. Hence, 
it follows the excursion criteria. 

Peak 2 is above the threshold level, but it does not rise and fall by the excursion value 
above the threshold level. Hence, it does not satisfy excursion criteria. 

Peak 3 rises above the threshold value by at least the excursion value, but it does not 
completely fall by the excursion value. The signal rises and crosses the Peak 3 
amplitude level. Hence, it is not an eligible peak. 

Peak 4 rises and falls by at least the peak excursion value above the threshold. 
Although during the rise it slightly falls (Peak 3) the net rise from the threshold level 
exceeds the excursion value. Hence, it is considered an eligible peak. 

Peak 5 is below the threshold level. Hence, it is not detected as a peak. 

Peak 6 rises by at least the peak excursion value above the threshold. During the fall, 
the signal slightly rises (as Peak 7), but it does not rise above peak 6 amplitude level 
before falling again. The total fall, which starts at the peak 6 amplitude level, is more 
than the excursion value. Hence, it is an eligible peak. 

Peak 7 falls by the excursion value, but it does not rise by the excursion value. Hence, it 
does not satisfy excursion criteria. 

FFT Averaging Modes 

You can perform averaged measurements on an FFT channel to improve measurement 
accuracy or to help compensate for a low signal-to-noise ratio. 

• Disabled—Disables FFT averaging. 
• RMS—Root mean square. RMS averaging averages the energy (or power) of the 

signal, so it reduces signal fluctuations, but not the noise floor. 
• Peakhold—Performs a peak hold averaging measurement at each individual 

frequency line and retains the RMS peak levels of the averaged quantities from one 
FFT record to the next. Peak-hold averaging is the most useful when configuring a 
measurement system or when applying limit or upper limit testing to a frequency 
spectrum. 
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Measuring Spectral Density 

A power spectral density is the measure of a signal's power content versus frequency. 
You can view the power spectral density of a signal while analysing data in the 
frequency domain; this is helpful for determining which frequency ranges have strong 
or weak variations in power. 

Complete the following steps to measure spectral density in InstrumentStudio: 

1. Add an oscilloscope to the large panel. 
2. Create an FFT channel by selecting the FFT button in the Add Channels section of 

the large panel. 
A frequency chart opens underneath the large panel time chart. 

3. Configure the FFT Axis settings: 
a. In the header of the frequency chart, select the Chart Options button. 
b. In the Y-axis section, change Units to V/√(Hz) or dBm/Hz. 
c. In the X-axis section, set Scaling to Logarithmic. 

4. Run the panel if it is not already running. 
InstrumentStudio plots power spectral density data on the Frequency chart. 

For better frequency resolution, you can configure averaging through the FFT channel 
settings, or you can modify the RBW through the axis settings in Chart Options. 

Measurement Types Measurement Types 

The following measurement types are available when creating oscilloscope channels 
with InstrumentStudio. 

Amplitude Mid Ref Volts Mean Negative Duty Cycle 

Peak-to-Peak Low Ref Volts Median Positive Pulse Width 

High Positive Undershoot Cycle RMS Negative Pulse Width 

Low Negative Undershoot Cycle Mean Rise Time 

Maximum Positive Overshoot Period Fall Time 

Minimum Negative Overshoot Frequency Rise Rate 

High Ref Volts RMS Positive Duty Cycle Fall Rate 
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Delta Time Setup Time Hold Time Crosspoint Voltage 

Crosspoint Time FFT Frequency FFT Amplitude 

Related tasks: 

• Customizing Oscilloscope Measurements 

Amplitude 

The voltage High measurement minus the voltage Low measurement. 

Peak-to-Peak 

The Maximum measurement minus the Minimum measurement. 

High 

The High measurement is calculated using the selected High-Low method. If you select 
the Histogram High-Low method, the High measurement is calculated using the most 
common value found in the upper 40% of the waveform. If you select the Peak High-
Low method, the High measurement is calculated using the waveform's Maximum 
measurement value. 

Low 

The Low measurement is calculated using the selected High-Low method. If you select 
the Histogram High-Low method, the Low measurement is calculated using the most 
common value found in the lower 40% of the waveform. If you select the Peak High-
Low method, the Low measurement is calculated using the waveform's Minimum 
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measurement value. 

Maximum 

The maximum value found in the waveform. 

Minimum 

The minimum value found in the waveform. 

High Ref Volts 

The voltage of the signal at the High reference level. If you set the reference level unit 
to Percentage, the High Ref Volts measurement is calculated with the selected High-
Low method. If you set the reference level unit to Volts, the voltage you set as the High 
reference level is used for the High Ref Volts measurement. 

Mid Ref Volts 

The voltage of the signal at the Mid reference level. If you set the reference level unit to 
Percentage, the Mid Ref Volts measurement is calculated with the selected High-Low 
method. If you set the reference level unit to Volts, the voltage you set as the Mid 
reference level is used for the Mid Ref Volts measurement. 

Low Ref Volts 

The voltage of the signal at the Low reference level. If you set the reference level unit to 
Percentage, the Low Ref Volts measurement is calculated with the selected High-Low 
method. If you set the reference level unit to Volts, the voltage you set as the Low 
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reference level is used for the Low Ref Volts measurement. 

Positive Undershoot 

Negative Undershoot 

Positive Overshoot 

Negative Overshoot 

RMS 

The true root mean square voltage over the entire waveform. This measurement uses 
the following formula: 

        RMS = sqrt[(sum(square(waveform[i]) / number of points)))] 
      

Mean 

The mean over the entire waveform. 
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Median 

The median over the entire waveform. The points in the waveform are sorted 
according to the following formulas: 

Number of Points Returned Value 

Odd waveform[(n-1)/2] 

Even (waveform[m/2] + waveform[n/2 +1]) / 2 

Cycle RMS 

The true root mean square voltage over the first cycle of the waveform. The first cycle 
is determined using the values specified by the High, Mid, and Low reference levels. 
This measurement uses the following formula: 

        Cycle RMS = sqrt[(sum(square(waveform[i]) / number of points)))] 
      

where waveform is all the points in the first cycle of the waveform. 

Cycle Mean 

The voltage average over the first cycle of the waveform. The values you specify in the 
High, Mid, and Low reference level fields in the Settings tab of the Measurements 
window determine the first cycle. 
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Period 

The time of the first two Mid reference level crossings in the same direction. A 
hysteresis is applied using the values specified by the High or Low reference levels. 

Frequency 

1.0 divided by the Period measurement, in hertz. 

Positive Duty Cycle 

The Positive Pulse Width divided by the Period times 100. 

        Positive Duty Cycle = (Positive Pulse Width/Period) × 100 
      

Negative Duty Cycle 

The Negative Pulse Width divided by the Period times 100. 

        Negative Duty Cycle = (Negative Pulse Width/Period) × 100 
      

Positive Pulse Width 
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The time difference in seconds between the first two Mid reference level crossings, 
where the first slope is positive and the second is negative. The High or Low reference 
levels are used to apply a hysteresis. 

Negative Pulse Width 

The time difference in seconds between the first two Mid reference level crossings, 
where the first slope is negative and the second is positive. The High or Low reference 
levels are used to apply a hysteresis. 

Rise Time 

The time span of the first rising edge of the waveform to cross the Low reference level 
until it crosses the High reference level. The time span starts from the Low reference 
level crossing immediately preceding the High reference level crossing. 

Fall Time 

The time span between when the first falling edge of the waveform crosses the High 
reference level to when the same falling edge crosses the Low reference level. 

Rise Rate 

The Rise Time divided by the High reference level minus the Low reference level. 
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        Rise Rate = Rise Time / (High reference level - Low reference level) 
      

Fall Rate 

The Fall Time divided by the High reference level minus the Low reference level. 

        Fall Rate = Fall Time / (High reference level - Low reference level) 
      

Delta Time 

The time span from when the first edge of the waveform crosses the Mid reference 
level until the second edge of the waveform crosses the Mid reference level. The 
second edge can be configured to another channel. 

Setup Time 

The time span from when the waveform crosses the Mid reference level until the 
configured clock channel crosses the Mid reference level. The Setup Time 
measurement uses the crossing of the clock channel that is closest to the middle of the 
graph. 

Hold Time 
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The time span from when the configured clock channel crosses the Mid reference level 
until the waveform crosses the Mid reference level. The Hold Time measurement uses 
the crossing of the clock channel that is closest to the middle of the graph. 

Crosspoint Voltage 

The voltage at which two waveforms intersect. The second waveform can be 
configured to another channel. The crosspoint voltage measurement uses the 
intersection closest to the middle of the graph. 

Crosspoint Time 

The time at which two waveforms intersect. The second waveform can be configured 
to another channel. The crosspoint time measurement uses the intersection closest to 
the middle of the graph. 

FFT Amplitude 

Calculates a real FFT and returns the maximum amplitude. The search ignores the DC 
bin of the FFT; peaks close to DC (but not in the DC bin) are detected. 

FFT Frequency 

Calculates a real FFT and returns the frequency that corresponds to the maximum 
amplitude. The search ignores the DC bin of the FFT; peaks close to DC (but not in the 
DC bin) are detected. 
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Customizing Oscilloscope Measurements Customizing Oscilloscope Measurements 

You can use reference levels and gating to customize the measurements displayed in 
the measurement table. To customize these settings: 

1. Click Add/Remove in the measurement table of an oscilloscope. 
2. Click the Settings tab of the Measurements window to configure oscilloscope 

measurements. 

Related reference: 

• Measurement Types 

Gating 

Use gating options to select the region of captured data used to perform 
measurements displayed in the measurement table. 

• Screen—Performs measurements only on the data visible in the large panel's Time 
domain graph. 

• Record—Performs measurements on the full data record. 
• Custom— Performs measurements only on the data between set positions. 

Configure custom gating positions using time values relative to the triggered data 
capture starting point. 
◦ Position 1—Sets the first position of gated data relative to the trigger to 

calculate measurements. 
◦ Position 2—Sets the second position of gated data relative to the trigger to 

calculate measurements. 

Reference Levels 

Customize the oscilloscope measurements displayed on the measurement table by 
adjusting the reference levels and the High-Low method from the Settings tab of the 
Measurements window. 

High, Mid, and Low Reference Levels 

Reference levels are range values that divide a waveform into high, middle, and low 
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sections by intersecting the waveform at specified amplitude. Use reference levels to 
ascertain rise and fall times, calculate waveform cycles, and customize some 
oscilloscope measurement types. In InstrumentStudio, set reference levels by either 
absolute voltage levels or the percentage of the waveform to acquire. The following 
oscilloscope measurement types are calculated using reference levels: 

• High Ref Volts 
• Mid Ref Volts 
• Low Ref Volts 
• Cycle RMS 

• Cycle Mean 
• Period 
• Rise Time 

• Fall Time 
• Rise Rate 
• Fall Rate 

Reference Level Unit 

Use the reference level Unit settings to specify whether reference levels should be 
interpreted as percentages of the waveform or as absolute levels. 

• Percentage—Interprets the reference levels as a percentage using the selected 
High-Low method. 

• Volts—Interprets the reference levels as absolute levels, in units of volts. 

High-Low Method 

If you set the reference level Unit setting to Percentage, configure how the state levels 
are computed by selecting the High-Low method: 

• Auto-select—Determines whether the histogram bins that correspond to the high 
and low state levels each have over 5% of the total hits. If so, the device returns 
those results. If not, the device uses the Peak High-Low method. The Auto-select 
High-Low method provides an answer for either a square wave (by ignoring the 
overshoot and undershoot) or a triangle wave (where the Histogram High-Low 
method fails). 

• Histogram—Computes state levels using the histogram bins with the maximum 
number of hits in the upper and lower regions of the waveform. The upper and 
lower regions of the waveform include the upper and lower 40% of the peak-to-
peak range of the waveform. 

• Peak—Searches the waveform for its maximum and minimum levels. 
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Network Analyzers Network Analyzers 
Refer to the following sections for information about setting up a network analyzer 
instrument in InstrumentStudio. 

Characterizing RF Devices 

Use the Network Analyzer instrument to perform measurements and characterize RF 
devices. 

1. Create a Network Analyzer instrument by clicking  » Network Analyzer. 
2. Click the  button to open the settings panel and configure the instrument. 
3. If you have not already done so, calibrate your Network Analyzer and apply 

corrections before proceeding to the next step. Uncalibrated devices may generate 
unexpected and inaccurate results when taking measurements. 

4. Connect your DUT, if it is not already connected. 
5. Run the measurement by clicking RUN to measure continuously or SINGLE to 

capture a single measurement. 

Applying Corrections to Network Analyzers 

Applying adjustments generated during the calibration process is critical to ensuring 
accurate measurements. 

Make sure you have already performed calibration on your device and saved a calset 
file before proceeding. 

1. Click Load Calset from File. 
2. Select the calibration data file that corresponds to your current configuration and 

click Open. 
3. Make sure the Correction Enabled box is checked. 

Adjustments will now be automatically applied when using this instrument. 

Note The RFmx VNA personality is supported for use with network analyzer 
instruments. 
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Related information: 

• PXIe-5842 Self-Calibration 

RF Signal Analyzers RF Signal Analyzers 
Refer to the following sections for information about setting up an RF signal analyzer 
instrument in InstrumentStudio. 

Analyzing RF Signals with an RF Signal Analyzer 

Create an RF signal analyzer panel to monitor and configure RF signal analyzer settings 
in InstrumentStudio. 

1. Create an RF Signal Analyzer panel. 
The default Spectrum Analyzer view will appear in the instrument panel. 

2. Select the personality you want to use to measure from the RFmx Personalities 
dropdown. 

The instrument panel and highlighted settings in the instrument configuration 
panel will change based on selected personality. 

3. Select the desired measurements from the settings panel using the Add/Remove 
button. 

4. Configure center frequency, reference level, and any other important values for the 
signal being analyzed in the settings panel. 

5. View the results and traces in the measurement pane. 

Supported RFmx Personalities 

The following list contains the RFmx personalities supported in InstrumentStudio for 
use with RF Signal Analyzer panels. 

• Spectrum Analyzer 

Note If the desired personality does not appear in the dropdown, make 
sure the personality is supported in InstrumentStudio, and make sure the 
driver for that personality is installed. 
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• GSM 
• LTE / LTE-Advanced 
• NR 
• TD-SCDMA 
• WCDMA 
• Bluetooth 
• WLAN 
• Pulse 

De-Embedding RFSA Devices 

De-embedding refers to the process of removing the effects of test fixture cabling 
and components. Applying de-embedding to an RF signal ensures more accurate 
results when reading data from your RF device. Once applied, the de-embedded signal 
you see at the device port matches the requested signal settings. 

De-embedding 

To access de-embedding properties, open the RF device Instrument Settings dialog 
box ( ), click the RF tab, and scroll down to De-embedding. The following are options 
you can configure to apply de-embedding your RF device: 

• Type—Specifies the type of de-embedding you want to use. 
◦ None—De-embedding is disabled. 
◦ Scalar—De-embeds the signal using the gain term. 
◦ Vector—De-embeds the signal using the gain term and reflection term. 

• Status—Displays whether an S2P table is loaded into the device session. 
• Load table from S2P file—Loads an S2P file into the device session to use for de-

embedding. 

Note 
◦ S2P tables are used to incorporate S-parameters into signal de-

embedding. S-parameters characterize the effects of a linear 
network on a signal when it passes from one port to another. Refer 
to the installed RF driver documentation for more information. 

◦ You must configure de-embedding for each port when using multi-
port modules. 
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Performing RF Signal Analyzer Self-Calibration 

Self-calibrate an RF signal analyzer device to ensure accurate measurements. 

The accuracy of a device will naturally drift over time. Self-calibration ensures more 
accurate measurements by compensating for board level temperature variations and 
device degradation, as well as ensuring that the device operates within ranges defined 
in your test specifications. 

Performing Self-Calibration 

1. In the device panel, open the instrument header menu ( ). 
2. Click Device Slot » Calibration » Self Calibrate... to begin self-calibration. 

3. Click Continue to proceed. 

Performing Self-Calibration Range 

This mode of calibration completes more quickly than general self-calibration. 

1. In the device panel, open the instrument header menu ( ). 
2. Click Device Slot » Calibration » Self Calibrate Range.... 
3. Under Steps to omit in the dialog box, select any steps you want InstrumentStudio 

to skip during the self-calibration process. 
4. Under Ranges, enter the values for the desired ranges of self-calibration. 
5. Click Continue to proceed, or Cancel to cancel the operation. 

Checking Calibration History 

1. In the device panel, open the instrument header menu ( ). 
2. Click Device Slot » Calibration » History. 

Note InstrumentStudio will warn you that the process may take several 
minutes to finish, and will lock the instrument until the process 
completes. 

Note This calibration is only valid until you restart your system. 
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Importing Bitfile Data 

Bitfiles define FPGA configurations, enabling you to customize your RF device for 
specific testing applications. Loading a bitfile to an InstrumentStudio RFSG or RFSA 
instrument will both load the specified configuration on the hardware device, as well 
as set the file as the default file to associate with the device model in 
InstrumentStudio. Complete the following steps to associate an existing bitfile with 
your RF instrument. 

1. In the device panel, open the instrument header menu ( ). 
2. Click Bitfile. 

3. Select the bitfile you want to use and click OK. 
InstrumentStudio prompts you to restart the application. You must restart 
InstrumentStudio before changes take effect. 

InstrumentStudio uses the selected bitfile as the default file for both RFSG and RFSA 
instruments for this device model. 
Related information: 

• niRFSA API Reference Manual 
• niRFGS API Reference Manual 

RF Signal Generators RF Signal Generators 
Refer to the following sections for information about setting up an RF signal generator 

Note Your device must have a user-accessible FPGA to load custom bitfiles. 
Refer to the niRFSA and niRFSG API reference manuals for details on which 
devices support this feature. 

Note A bitfile must be present in the following folder before you can 
complete this step: 

User\Public\Documents\National Instruments\FPGA Extensions Bitfiles\
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instrument in InstrumentStudio. 

Generating RF Signals with an RF Signal Generator 

Create an RF signal generator panel to monitor and configure RF signal generator 
settings in InstrumentStudio. 

1. Add an RF signal generator device to your panel. 
2. Select a mode of operation within the device panel. 

◦ CW—Configures the RF signal generator to generate a continuous waveform 
signal. 

◦ Arb—Configures the RF signal generator to generate an arbitrary waveform 
using the settings specified in an external file and any additional settings you 
specify. 

3. Specify the type of signal to generate. 
◦ If you want to generate a CW signal, specify the signal settings by opening the 

Instrument Settings ( ) dialog box. 
◦ If you want to generate an arbitrary waveform, click the Add Waveform button 

next to Select Waveform. Then select a waveform file. Specify the signal 
settings by opening the Instrument Settings ( ) dialog box. 

4. Select Run and set the output to On. The signal generates with the settings you 
specify. 

Note Arbitrary waveform files must be in the .tdms format. 

Note 
◦ The panel will already be running in CW mode, and you only need 

to set output to On to output a generated waveform. In Arb mode, 
you must first select a waveform, then press Run. 

◦ The panel will continue running and generate the waveform 
continuously unless you set Waveform repetition mode is to Finite 
when configuring your signal settings. When set to Finite, the panel 
will output the specified number of repetitions and then stop. 
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Arbitrary Waveform Properties 

Waveform properties are settings and values associated with waveforms generated in 
Arbitrary Waveform mode. 

When changing a waveform, waveform property values update to reflect the settings 
for that waveform. When downloading a waveform from file, the property values are 
automatically populated with the values found in the file. Any changes made to the 
waveform properties only affect the selected waveform. 

Debugging Test Programs Debugging Test Programs 

Waveform properties were introduced in the NI-RFSG 20.7 driver. Prior to that release, 
only a subset of these properties was available, and they applied globally to all 
waveforms. When debugging a test program that still utilizes these global properties, 
the global values will be shown for the selected waveform. Any subsequent edits in 
InstrumentStudio will only apply to the selected waveform. 

The following table shows legacy property names that map to new RFSG property 
names: 

Global Property Name RFSG Arbitrary Waveform Property Name 

IQ Rate IQ Rate 

Peak Power Adjustment PAPR 

Pre-filter Gain Run time Scaling 

Signal Bandwidth Signal Bandwidth 

Performing RF Signal Generator Self-Calibration 

Self-calibrate an RF signal generator device to ensure accurate measurements. 

The accuracy of a device will naturally drift over time. Self-calibration ensures more 
accurate measurements by compensating for board level temperature variations and 
device degradation, as well as ensuring that the device operates within ranges defined 
in your test specifications. 
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Performing Self-Calibration 

1. In the device panel, open the instrument header menu ( ). 
2. Click Device Slot » Calibration » Self Calibrate... to begin self-calibration. 

3. Click Continue to proceed. 

Performing Self-Calibration Range 

This mode of calibration completes more quickly than general self-calibration. 

1. In the device panel, open the instrument header menu ( ). 
2. Click Device Slot » Calibration » Self Calibrate Range.... 
3. Under Steps to omit in the dialog box, select any steps you want InstrumentStudio 

to skip during the self-calibration process. 
4. Under Ranges, enter the values for the desired ranges of self-calibration. 
5. Click Continue to proceed, or Cancel to cancel the operation. 

Checking Calibration History 

1. In the device panel, open the instrument header menu ( ). 
2. Click Device Slot » Calibration » History. 

RF Signal Generator Status 
An RF signal generator can be in one of the following states: 

• Generating Output—Signal generation is running and being output on this 
channel. Generating can also mean the channel is waiting for a trigger. 

• Not Generating Output—Signal generation is stopped on this channel. 
• Unknown—Signal generation status is unknown. 

Note InstrumentStudio will warn you that the process may take several 
minutes to finish, and will lock the instrument until the process 
completes. 

Note This calibration is only valid until you restart your system. 
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De-embedding RFSG Devices 

De-embedding refers to the process of removing the effects of test fixture cabling 
and components. Applying de-embedding to an RF signal ensures more accurate 
results when reading data from your RF device. Once applied, the de-embedded signal 
you see at the device port matches the requested signal settings. 

De-embedding 

To access de-embedding properties, open the RF device Instrument Settings dialog 
box ( ), click the RF tab, and scroll down to De-embedding. The following are options 
you can configure to apply de-embedding your RF device: 

• Type—Specifies the type of de-embedding you want to use. 
◦ None—De-embedding is disabled. 
◦ Scalar—De-embeds the signal using the gain term. 
◦ Vector—De-embeds the signal using the gain term and reflection term. 

• Status—Displays whether an S2P table is loaded into the device session. 
• Load table from S2P file—Loads an S2P file into the device session to use for de-

embedding. 

RF Signal Generator Modes 

You can generate an RF signal using one of the following three modes: 

Note The panel must be running and the output set to On for the RF signal 
generator to output the waveform. Output stops when closing an RF signal 
generator panel except when monitoring an external session. 

Note 
◦ S2P tables are used to incorporate S-parameters into signal de-

embedding. S-parameters characterize the effects of a linear 
network on a signal when it passes from one port to another. Refer 
to the installed RF driver documentation for more information. 

◦ You must configure de-embedding for each port when using multi-
port modules. 
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• Continuous Waveform (CW)—Configures an RF signal generator to output a 
continuous waveform at the specified frequency and level. 

• Arbitrary Waveform (Arb)—Configures an RF signal generator to output a complex 
signal according to the waveform and waveform settings specified in an external 
file. 

• Script—Configures an RF signal generator to output a sequence of multiple 
waveforms according to settings specified in an external script. This option is only 
available in debug mode, and is only supported when controlling an external 
session configured to script mode. For more information on scripting, refer to NI-
RFSG driver documentation at ni.com. 

SMU and VPS Devices SMU and VPS Devices 
Refer to the following sections for information about setting up a SMU and VPS 
instruments in InstrumentStudio. 

SMU/VPS Modes of Operation 

Device Operating Modes 

You can use one of the following modes for acquiring measurements using an SMU or 
VPS device in InstrumentStudio: Chart, Waveform, and Sweep. 

Operating 
Mode 

Sourcing 
Behavior 

Large Panel 
Plotting 

Behavior 

Pause 
Behavior 

Potential 
Uses Notes 

Chart 

Allows one or 
more 
channels to 
source 
current or 
voltage. 

Appends 
samples to 
the chart as 
they are 
measured. 

Channels 
continue to 
source at the 
last configured 
level when you 
pause 
measurements. 

Observe 
signals over 
an infinite 
duration. 

Waveform 

Allows one or 
more 
channels to 
source 
current or 

Plots samples 
to the graph 
all at once; 
the length of 
the graph is 

Channels 
continue to 
source at the 
last configured 
level when you 

Observe 
signals over a 
shorter, finite 
duration, 
similar to an 

Unless you press 
Single, 
InstrumentStudio 
automatically 
configures the 
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Operating 
Mode 

Sourcing 
Behavior 

Large Panel 
Plotting 

Behavior 

Pause 
Behavior 

Potential 
Uses Notes 

voltage. 
determined 
by capture 
time. 

pause 
measurements. oscilloscope. 

device for a faster 
sample rate and 
runs the output 
continuously in a 
loop. 

Sweep 

Sweeps 
through 
configured 
current or 
voltage steps 
for a single 
channel 
(Single-
Channel 
Sweep) or two 
channels 
(Two-Channel 
Sweep). 

Plots sample 
step results 
on the graph 
as they are 
measured. 

Both 
measurement 
and output 
channels are 
paused when 
you pause 
measurements. 

Allows you to 
plot the 
relationship 
between 
current and 
voltage in an 
I-V curve. 

When you are 
using Two-
Channel Sweep, 
the sweep acts as 
a nested loop, 
where the inner 
channel executes 
all the steps for 
each step 
configured in the 
outer channel. 

Sweep (LCR 
Mode) 

Sweeps 
through 
configured 
frequency or 
DC bias steps 
for a single 
channel 
(Single 
Channel 
Sweep) 

Plots sample 
step results 
on the graph 
as they are 
measured. 

Both 
measurement 
and output 
channels are 
paused when 
you pause 
measurements. 

Allows you to 
plot the 
relationship 
between 
frequency or 
DC bias and 
enabled LCR 
readbacks. 

Note Waveform and Sweep modes are not available on PXI-4110, PXIe-4112, 
PXIe-4113, PXI-4130, or PXI-4132 devices. 

Note Waveform mode is only available for single-channel sessions in debug 
mode. Waveform mode is disabled when a session contains two channels. 

Configuring Panels and Layout

© National Instruments 83



Channel Operating Modes 

In addition to device operating modes, you can also specify an operating mode for 
each channel. Some channel operating modes are only available on devices with 
certain capabilities. 

If you change the operating mode of a channel, all panel measurements are paused. 
Any enabled outputs continue to generate signal at the last configured level. The new 
operating mode of the channel will not take effect until you run the panel. 

• Idle—The channel is not programmed. If you change a channel to Idle from another 
mode, the channel continues to generate signal according to its last configuration. 

• Voltage or Current—Sources DC voltage or DC current at a single configured level 
while the output is enabled. 

• Pulse voltage or Pulse current—Generates a single pulse at the pulse level, then 
returns to the bias level. 

• Voltage sequence or Current sequence—Allows you to configure a level and a 
duration for each step in a list. You can configure the list of steps on the device 
panel, or import steps from a .CSV file. For more information on creating voltage or 
current sequences, refer to Configuring Sequences. 

Note Sweep mode is available on PXIe-4190 device when operating in LCR 
mode. To change to LCR mode, go to the Channel settings within the device 
panel, click the Mode drop-down, and select LCR meter. 

Note 
◦ For more information on pulsing and devices that support pulse 

measurements, refer to Pulsing in the NI-DCPower help. 
◦ InstrumentStudio currently supports single point pulsing only; 

InstrumentStudio 2019 does not support pulse sequencing. 

Note 
◦ If you import a step sequence from a .CSV file, the .CSV file must 

have two columns: the first for the level, and the second for the 
duration. 
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SMU Measurement Autorange 

When the range for a signal is unknown, using measurement autorange enables the 
signal range to be automatically determined. 

When a measured signal exceeds the specified range in InstrumentStudio, 
InstrumentStudio will not be able to accurately measure that signal, and will warn you 
that the measurement is over range. When you enable measurement autorange, 
InstrumentStudio uses incoming signal data to automatically set measurement ranges, 
ensuring more accurate measurements. 

Enabling Autorange 

1. To enable autorange mode for an SMU or VPS device, click the Measurement 
Autorange toggle within the device panel and ensure it is in the On position. 

2. Optional: Use the device panel to configure autorange settings. 
3. Optional: To disable autorange, click the Measurement Autorange toggle again 

and ensure it is in the Off position. 

Configuring Autorange 

Use the following controls in the SMU or VPS device panel to specify how you want 
autorange to respond to incoming signals from your device. 

• Aperture time mode — Specifies whether the aperture time used for measurement 
autorange is determined automatically or customized using the value specified by 
the Minimum aperture time setting. 

• Minimum aperture time — Specifies the aperture time used by the measurement 
autorange algorithm. 

◦ Voltage sequence and Current sequence modes are not available 
on the PXI-4110, PXIe-4112, PXIe-4113, PXI-4130, or PXI-4132 
devices. 

Note Autorange mode must be enabled to access these settings in your 
device panel. 
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• Minimum aperture time units — Specifies the units of the Minimum aperture time
setting. Aperture time can be specified in seconds or power line cycles (PLCs). 

• Autorange behavior — Specifies the algorithm the hardware uses for 
measurement autoranging. Choose from the following behaviors. 
◦ Range up to limit then down — go to range limit the range down until 

measured value is within thresholds. 
◦ Range up — go up one range when upper threshold is reached. 
◦ Range up and down — go up or down one range when the upper or lower 

threshold is reached. 
• Minimum current range — Specifies the lowest range used during measurement 

autoranging. 

NI-DCPower Independent Channel Sessions 

InstrumentStudio creates a single multi-channel session for all devices in a single SMU 
device by default. 

Considerations when configuring sessions with SMU devices 

Using independent channels allows you to configure multiple channels of the same 
instrument, or multiple instruments, within the same session independently of one 
another. InstrumentStudio exports a single session configuration for all channels by 
default. In certain cases, you must change your session type to Single channel 
(compatibility) mode. 

Note This is a minimum value, and will be scaled up to optimize the 
algorithm for different ranges. For smaller ranges, the value will be scaled 
up to account for signal noise. 

Note Limiting the lowest range can improve the speed of autoranging 
and minimize thrashing between ranges when measuring a noisy signal. 

Note This is not default behavior in some versions of InstrumentStudio. 

Note To manually select the session type you want to use, open the 
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You should select Session Type » Single channel (compatibility) when: 

• Exporting a session to platforms which do not support NI-DCPower independent 
channel sessions. These include Python, LabWindows/CVI, LabVIEW NXG, and 
Linux desktop. 

• Exporting a session to NI-DCPower version 20.5 and earlier. 
• Exporting the session to end-user code which uses deprecated NI-DCPower 

Initialize Functions in C/LabVIEW or deprecated constructors in .NET. 

• 

Output Status 

You can determine the current output status of non-idle channels with the output 
status icon, located at the top of the Channels section of an SMU/Power Supply panel. 

Table 2. SMU/Power Supply Channel Output Status 

Icon Status Description 

Generating Output 
One or more channels in the 
panel are sourcing voltage or 
current. 

Not Generating Output No channels in the panel are 
sourcing voltage or current. 

Waiting for Trigger 

Channels in the panel are 
waiting until the trigger 
condition has been met to start 
an operation. 

Unknown Status The output status of the 

instrument header menu ( ) of the device in your panel, and click Session 
Type. 

Note Exports from sessions created in InstrumentStudio with 
independent channels cannot be imported into sessions created with 
single channels. To verify your session channel configuration, go to the 
instrument header menu ( ) and click Session Type. 
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Icon Status Description 

channel(s) in the panel is 
unknown. Run the panel to 
refresh the output status. 

Configuring SourceAdapt Parameters to Measure Transients 
You can use SourceAdapt technology to customize the source measure unit (SMU) 
response to any load. For more information on National Instruments' SourceAdapt 
technology, refer to NI SourceAdapt Next-Generation SMU Technology on ni.com. 

Selecting a SourceAdapt Preset 

1. Place a SourceAdapt-compatible SMU in the large panel. 
2. Place the SMU panel into Waveform mode. 
3. Open the Channel Settings window. 
4. Scroll down to the SourceAdapt tuning parameters section of the Channel Settings 

window. 
5. Select a SourceAdapt preset from the list: 

◦ Slow—Slows the control loop for a more stable response. 
◦ Normal—The default SourceAdapt preset, a balance between speed and 

stability. 
◦ Fast—Speeds up the control loop for a faster response. 

6. (Optional) Make custom adjustments to the response using the fields in the 
SourceAdapt tuning parameters section. 

Configuring Sequences 

You can change the channel operating mode of an SMU/Power Supply channel to 
Voltage Sequence or Current Sequence mode to enable power sequencing. Power 
sequencing allows you to output the desired power-up sequence for a DUT with 
multiple power sources by configuring the order, timing, and level of each power 

Note Output continues when closing a panel. 

Note NI SourceAdapt technology is available only on the following SMUs: 
PXIe-4135, PXIe-4137, and PXIe-4139. 
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supply channel. 

1. Place an SMU or power supply in a panel. 
If you place the device in a large panel, the graph shows a preview of the output 
sequence the channel will generate. 

2. Set the operating mode of the panel to Waveform or Charting. 
Placing the panel in Waveform mode enables fast sampling and allows you to 
visualize the sequence in more detail. 

3. Set the channel operating mode to Voltage sequence or Current sequence. 
A step table appears within the channel. 

4. Edit the steps in the step table by entering the values manually, importing data 
from a file, or pasting data from the clipboard. 

5. (Optional) Tune the output of the sequence using SourceAdapt parameters, found 
in the Channel Settings window. 

6. Enable the channel output and run the panel to begin the sequence. 

Waveform Generators Waveform Generators 
Refer to the following sections for information about setting up a waveform generator 
instrument in InstrumentStudio. 

Note 

• Channels within the same panel operating in Voltage Sequence, 
Current Sequence, Pulse Voltage, or Pulse Current mode are 
automatically hardware-synchronized. Refer to Multi-Device 
Synchronization for more information on hardware and software 
synchronization within panels. 

• Sequence channel operating modes are supported only on power 
supplies that support advanced sequencing. For more information on 
advanced sequencing and supported devices, refer to NI-DCPower 
Advanced Sequencing documentation. 
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Generating Waveforms with a Waveform Generator 

Use a waveform generator to monitor and configure waveforms in InstrumentStudio. 

1. Add a waveform generator device to the large panel. 
2. Select a waveform mode from the drop-down menu in the upper-right corner of 

the large panel. 
◦ Standard waveform—Generates a waveform using the channel settings you 

specify. 
◦ Arbitrary waveform—Generates a waveform using settings specified in a 

waveform file and any additional channel settings you specify. 
3. Specify the type of waveform to generate. 

◦ If you are generating a standard waveform, select the waveform type using the 
Waveform drop-down menu. 

◦ If you are generating an arbitrary waveform, load a waveform file using the 
Filename field. The waveform file specifies the type of waveform to generate. 

Note If you select a User-defined waveform, you must load a 
waveform file. User-defined waveform files must be in CSV format, 
with the exact number of samples listed in your device's 
specifications document. For example, the PXIe-5433 requires 8192 
samples for a user-defined waveform. The waveform samples may be 
in a single row or single column. 

Note Arbitrary waveform files must be in CSV format or binary 
format: 

▪ CSV—For single-channel instruments, waveform samples must 
be in a single row or a single column. For two-channel 
instruments, each channel's waveform samples must be in a 
separate column. 

▪ Binary—For single-channel instruments, waveform samples 
may be 8-byte double-prevision or 2-byte half-precision 
floating point, and the byte order may be little-endian or big-
endian. For two-channel instruments, both channels' samples 
must be interleaved. 
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4. Configure waveform channel settings using either the controls on the large panel 
or the large panel's Channel Settings window. Customizable settings change 
depending on the waveform mode and type you select. 

5. Select Run. 
The waveform generates with the settings you specified. 

Custom Waveform Channels and Triggers 

Use the following settings to configure channels, triggers, and other parameters of the 
waveform generator. 

Waveform Channel Settings 

• Output Impedance—Sets the output impedance value to either 50 Ω or 75 Ω. 
• Load Impedance—Sets the load impedance value to one of the following settings: 

◦ Match output—Matches the load impedance to the output impedance. 
◦ High-Z—Sets the load impedance to high impedance. 
◦ Custom—Sets the load impedance to a custom value, in ohms. 

• Digital Filter—Enables or disables the digital filter. The digital filter increases the 
effective sampling rate by providing points that interpolate between generated 
samples. 

• Analog Filter—Enables or disables the analog filter. The analog filter is applied 
after the interpolated signal, and, when combined with the digital filter, can 
remove high-frequency images from the frequency domain. 

• Terminal config.—Returns the terminal configuration for the waveform generator. 
Most waveform generators support only one option (differential or single-ended). 

Waveform General Settings 

• Waveform—Sets the type of waveform to generate if you are generating a standard 

Note If you are generating an arbitrary waveform, you must select a 
triggering mode for the waveform using the Mode setting. For more 
information on arbitrary waveform trigger modes, refer to Advanced 
Waveform Sequencing and Triggering on Arbitrary Waveform Generators 
at ni.com. 
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waveform. 

• Sample Rate—Sets the sample rate of an arbitrary waveform. 

Waveform Trigger Settings 

• Trigger Mode—Sets the mode for triggering arbitrary waveform generation. 

• Trigger Type—Sets the trigger type to one of the following values: 
◦ Immediate—Triggers waveform generation as soon as you run the waveform 

generator. 
◦ Software—Triggers waveform generation according to settings in an external 

application. 
◦ Digital edge—Triggers waveform generation on the rising edge of a specified 

source terminal. The source terminal must export a signal to use digital edge 
triggering. 

Hardware Event Output Terminals 

These settings determine to which chassis terminal(s) hardware events are exported. 

Waveform Modes 

You can generate a waveform using one of the following two modes: 

• Standard Waveform—Outputs waveforms according to the channel settings you 
specify in InstrumentStudio or an external application. Using a standard waveform 
allows you to generate several different standard waveform types (sine, square, 
etc.) at precise frequencies. 

Note 
◦ If you select User-defined, you must load a waveform file. User-

defined waveform file must be in CSV format. 
◦ Different waveform types have different configurable settings. 

Note For more information on arbitrary waveform trigger modes, refer 
to Advanced Waveform Sequencing and Triggering on Arbitrary 
Waveform Generators at ni.com. 
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You can also change the output waveform frequency of a standard waveform 
during generation with a short response time. You can also use the Sweep 
operating mode to configure a range of frequences to generate over a specified 
number of steps and time duration, or use the List operating mode to configure a 
sequence of frequencies to generate for specified durations. 

• Arbitrary Waveform—Outputs waveforms according to the settings specified in an 
external file. Using an arbitrary waveform allows you to define large, complex 
waveforms using a waveform settings file. While you can generate more complex 
waveforms using an arbitrary waveform, changes to arbitrary waveform settings 
have a longer response time than standard waveforms. 

Waveform Generator Status 
A waveform generator channel can be in one of the following states: 

• Stopped—Waveform generation is stopped on this channel. 
• Running—Waveform generation is running on this channel. 
• Waiting for trigger—Waveform generation is waiting until the trigger condition has 

been met. 

Exporting Configurations Exporting Configurations 
Refer to the following sections for information about exporting instrument and device 
configurations for use with other NI products. 

Exporting a Device Configuration 
Once you have configured a device in InstrumentStudio, you can export the device's 
settings to a device configuration file, which can then be imported to LabVIEW or 
another application to apply the device configuration to a different session. 

Note The user-defined standard waveform type allows you to generate a 
periodic waveform with a finite, specified number of points using Direct 
Digital Synthesis (DDS). To generate a user-defined waveform of any size, 
use Arbitrary Waveform mode. 

Note Generation stops when closing a panel. 
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To export a device configuration, complete the following steps: 

1. Configure the device's settings. 
2. Open the instrument header menu and select Export » Driver configuration... 
3. Select the location to save the configuration file. 

The device configuration file is saved to the location you specified. 

To apply device settings from a device configuration file to a device session in LabVIEW, 
you must first import the device configuration file to LabVIEW using a driver-specific 
LabVIEW VI called Import Attribute Configuration. Each driver has its own 
implementation of Import Attribute Configuration. Refer to the driver's documentation 
for more information: 

Device Driver Import Configuration VI 

NI-SCOPE NI-SCOPE Import Attribute Configuration File 

NI-DCPower NI-DCPower Import Attribute Configuration File 

NI-DMM NI-DMM Import Attribute Configuration File 

NI-FGEN NI-FGEN Import Attribute Configuration File 

Related concepts: 

Note 

• You cannot import a device configuration file into InstrumentStudio. If 
you would like to save a layout or device configuration for future use in 
InstrumentStudio, you can either save the entire project (File » Save 
all) or an individual device's soft front panel (File » Save [device 
name].sfp). 

• The following waveform modes are not supported when exporting a 
configuration that includes a waveform generator: 

◦ List and Sweep mode 
◦ Arbitrary waveform mode with a .CSV waveform type 
◦ User-defined waveform mode 
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• Configuring Panels with the Instrument Header Menu 

Exporting Configurations to TestStand 

Exporting configurations saves time when automating test sequences in TestStand. 
Once you configure your hardware in InstrumentStudio, you can export your 
configuration for use in TestStand sequences. You can export device and panel 
configurations to 64-bit TestStand 2019 or later. You can then use these configurations 
with LabVIEW, C#, C, or CVI automation code in a TestStand sequence. 

Refer to the following topics for more information on exporting device and panel 
configurations: 

• Exporting an InstrumentStudio Configuration 
• Inserting an InstrumentStudio Configuration in a TestStand Sequence 
• Editing an Exported Configuration 

Exporting an InstrumentStudio Configuration 

Before exporting an InstrumentStudio configuration to TestStand, make sure 
instrument channels you want to include in the export are not set to idle. Idle 
instrument channels are not exported to TestStand. 

1. From the top toolbar or the instrument header menu, select the Export to 
TestStand button ( ). 

2. Specify a name for the exported configuration. You can configure the default 

Note You must have TestStand 2019 or later installed for the Export to 
TestStand button to appear. 

Note You cannot export InstrumentStudio configurations to the 32-bit 
version of TestStand. 

Note You cannot export an InstrumentStudio configuration to TestStand 
while the site filter is set to "All sites". Select a specific site in the site filter, 
or select "System pins" to only export system pins. 

Configuring Panels and Layout

© National Instruments 95



TestStand export name format by selecting File » Preferences and navigating to 
the Export to TestStand section. 
InstrumentStudio creates an IO Configuration file, which contains both the driver 
configuration and the panel layout from InstrumentStudio. 

Inserting an InstrumentStudio Configuration in a TestStand Sequence 

When you insert an IO Configuration file into a TestStand sequence, TestStand creates 
a copy of the configuration file in the step you specify. When you run the sequence, the 
step creates sessions for the InstrumentStudio-configured instruments and applies the 
configuration to the new sessions. 

These created sessions are automatically stored in local variables in TestStand. You 
can then pass the session from the variable to automation code in Action steps, apply 
a new configuration to the existing session using the variable, or use the session in a 
Sweep loop to configure the sequence of values for certain attribute in each 
instrument. 

Editing an Exported Configuration 

You can edit an exported configuration in a specific TestStand step. Complete the 
following steps to edit an exported configuration from TestStand: 

1. Import an InstrumentStudio configuration to TestStand. 
2. Navigate to the TestStand step you would like to edit and select Edit. 

InstrumentStudio opens in Edit mode and displays the instrument panels in the 
same layout as the document you exported the configuration from. 

3. Edit the configuration in InstrumentStudio. 
4. Click OK. Any changes you made to the configuration commit back to the 

TestStand step or IO Configuration file you edited. 

Note For more information on using TestStand, refer to TestStand 
documentation on ni.com. 
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Capturing Data Capturing Data 
Using InstrumentStudio, you can capture data from an entire layout or a single panel. 
You can also take a screenshot without capturing data. 

Adjust data capture preferences by selecting File » Preferences and navigating to the 
Capture data tab. In this tab, you can set the destination directory and change the 
filename and format for both images and data. By default, images are captured in PNG 
and data is captured in the NI-TDMS format, but you can also capture data in CSV 
format. 

Capturing Data from a Layout 

Capture data from an entire layout by selecting the Capture data icon ( ) from the 
document toolbar, located just above the large panel. InstrumentStudio saves a 
timestamped screenshot and a data file to the destination directory. The screenshot 
contains the view of the entire layout at the time data was captured, and the data file 
contains detailed information about every device in the layout. 

Capturing Data from a Panel 

Capture data from a single panel by opening the instrument header menu ( ) and 
selecting Capture data. InstrumentStudio saves a timestamped screenshot and a data 
file to the destination directory. The screenshot contains the view of the panel at the 
time data was captured, and the data file contains detailed information about the 
device or devices in the panel. 

Capturing a Separate Screenshot 

If you want to capture a screenshot but not a data file, select the Capture screenshot 
icon ( ) from the document toolbar, located just above the large panel. 
InstrumentStudio attaches the screenshot to the clipboard. 

Parsing Captured Data 

Parse NI-TDMS data files using LabVIEW, LabWindows/CVI, DIAdem, VeriStand, or one 
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of several third-party applications. For more information on using the NI-TDMS file 
format, visit ni.com/info and enter the Info Code tdmsfileformat. 

Parse CSV files using a spreadsheet application for best results. CSV files sort channel, 
device, and measurement type into columns. Individual measurements and 
statistics—including mean, range, and standard deviation—are sorted into rows. 

Related concepts: 

• Configuring Panels with the Instrument Header Menu 
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  Sequencer Tool Sequencer Tool 
The sequencer tool enables you to perform a series of ordered tasks using instrument 
panels and measurement plug-ins. Automating using the sequencer tool can enable 
you to efficiently perform multi-step measurements, saving time and ensuring 
consistency. 

Related information: 

• Measurement Plug-In User Manual 

Supported Instruments 

The following section describes which instrument types are supported for use in the 
Sequencer Tool, and the supported operations for each instrument type. 

Instrument Panel Type Start Read Stop 

Digital Multimeter ✓ 

Waveform Generator ✓ ✓ 

Oscilloscope ✓ ✓ 

SMU/Power Supply ✓ ✓ ✓ 

Accessing the Sequencer Tool 

Complete the following steps to access the sequencer tool in InstrumentStudio. 

1. Required: Make sure you have activated your InstrumentStudio Professional 
license to use the sequencer tool. 

2. Click the Sequencer pane at the top of the project window. 

Note This feature is only available with an InstrumentStudio Professional 
license. 
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Building a Sequence 

Complete the following steps to create a new sequence step. 

Before you begin, make sure to save your current project. 

1. Navigate to the panel you want to add to a sequence. 
2. Click the Add to sequence button. 

To ensure the correct steps have been added to the sequence, open the Sequencer 
pane and check the list of steps displayed within the Step list view. 

Sweeps 

Sweeps enable you to repeat selected steps within a sequence to provide a range of 
data to parameters in individual measurement steps. 

Adding a Sweep Loop to a Sequence 

To add a sweep loop to a sequence, click the add step button (+) for the steps you want 
to sweep and select Sweep Loop. 

Sweep Behavior 

When you execute a sequence within your InstrumentStudio project that contains a 
sweep, the sequence will execute the steps within the sweep loop based on the 
parameter settings you select when configuring the sweep. In general, the sweep will 
execute once for each new parameter value specified in the sweep settings. 

For example, if you wanted to run a test sequence that sends a series of 3 different 
voltages to a device using an SMU panel, and then reads data back from the device 

Note You cannot use the Sequencer Tool within an unsaved project. 

Note Hover over the Add to sequence to see a list of all associated steps 
containing the selected panel. 
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using a DMM panel, the sequence would execute in the following order: 

• Sweep 1, Step 1, Parameter Value 1: SMU[Start] sends 1.15V to device. 
• Sweep 1, Step 2: DMM reads output from device. 
• Sweep 1, Step 3: SMU[Stop] 
• Sweep 2, Step 1, Parameter Value 2: SMU sends 1.35V to device. 
• Sweep 2, Step 2: DMM reads output from device. 
• Sweep 2, Step 3: SMU[Stop] 
• Sweep 3, Step 1, Parameter Value 3: SMU sends 1.5V to device. 
• Sweep 3, Step 2: DMM reads output from device. 
• Sweep 3, Step 3: SMU[Stop] 

Once a sweep loop has completed, the following steps of the sequence execute. 

Sweep Strategies 
You can configure sweep loop behavior by opening the step settings panel ( ). The 
following sweep strategies are available in the Sequencer tool: 

• Start, Stop, Step- Specify a start and stop value, and the step size to use. 
• Start, Stop, Count- Specify a start and stop value, and the amount of steps to use 

within that range. 
• Array- Manually specify a list of values to sweep through. 

Sweep Step Settings 
The following settings are available within the parameter settings panel. A preview of 
values will be shown for the selected settings. 

• Parameter- The name you want to use for the parameter to be swept. 
• Data Type- The data type of the parameter. Can be numeric, etc. 
• Strategy- Which sweep behavior you want to use. Refer to Sweep Strategies for 

more information on sweep types. 
• Distribution- How to distribute steps between the Start and Stop values specified 

for a sweep. Can be linear or geometric. 
• Start- The initial parameter value to use when performing a sweep. 
• Stop- The final parameter value to use when performing a sweep. 
• Step- The step size to use when selecting a Start, Stop, Step sweep strategy. 
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• Count- The number of steps to create when selecting a Start, Stop, Count sweep 
strategy. 

• Values- When using an Array sweep strategy, enter the values you want to sweep 
through using this table. When other strategies are selected, this table displays the 
values generated by the selected sweep settings. 

Configuring Sweep Parameters for Sequence Steps 

After configuring the sweep step settings, you can configure how each measurement 
step within the sweep will handle the sweep parameter. Sweep parameters for steps 
within a sweep are configured in the step settings. Measurement plug-in step settings 
enable you to use the sweep parameter for any appropriate step inputs. You can select 
the same sweep parameter on multiple step inputs. 

Supported Panel Types 

Sweeps are supported for use with measurement plug-in based panels. 

Modifying a Sequence 

Changing Sequencer Panel Configuration 

If you change the configuration of a measurement panel used in multiple steps, the 
changes are applied to all instances of that panel in the sequence. 

Reusing a measurement panel 

If you want to use different configurations with the same measurement panel, you 
must create a new panel. Click Duplicate Panel ( ) to quickly make a duplicate of the 
selected panel. 

Reordering a sequence 

To change the order of a step within a sequence, drag and drop the step to the desired 

Note Changes made to panel configurations are applied immediately. 
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position in the sequence. 

Viewing steps 

Double-click a step to quickly access and edit the measurement panel associated with 
it . 

Executing a Sequence 

Executing a sequence performs all the measurements defined in the sequence steps. 
Once the sequence has executed, you can view the measured data as well as the 
execution log to ensure the sequence has completed all steps successfully. 

Before executing a sequence, make sure all required devices within your system are 
present, connected, and powered on. 
Click Run to execute the sequence. 
The timer in the sequencer pane will start, signaling that the sequence is actively 
executing. 

Viewing a Sequence Execution Log 

InstrumentStudio generates an execution log each time a sequence is executed. This 
log lists information about each of the steps executed during a sequence. You can use 
the log to identify which steps executed, as well as the status and execution time of 
each step. 

1. Open the Sequencer pane. 
2. Click Execution Log. 

Note An execution report is created and saved in a folder titled Sequence 
Results in the project folder each time a sequence is executed. Refer to 
Viewing a Sequence Report for information on how to view sequence 
reports. 
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Viewing a Sequence Report 

A sequence report is a PDF file detailing the results of a sequence. Sequence reports 
are generated each time you execute a sequence. Complete the following steps to 
access a sequence report. 

1. Execute a sequence. 
2. When the sequence execution completes, click the View Report button. 

The generated report will open in your system default PDF viewer. 
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Debugging Programmatic Applications Debugging Programmatic Applications 
Use InstrumentStudio's debug mode to monitor and control devices in use by an 
external application. 

You can use InstrumentStudio to troubleshoot devices currently in use by an external 
application. An external application is any application running outside of 
InstrumentStudio, including LabVIEW, TestStand, or a C/C++/.NET application. 

If you receive unexpected results from a device in an external application, you can 
monitor the device in InstrumentStudio to assess the issue, troubleshoot the issue by 
changing the device's settings in InstrumentStudio, then continue with the external 
application. For example, you can pause the external application where you suspect an 
error, edit the device settings in InstrumentStudio, then resume the application with 
the new settings. 

Waveform Generator Debug Mode Limitations 

When using debug mode with a waveform generator, be aware of the following 
limitations: 

• Debug mode does not support arbitrary sequence or script modes. Controlling 
arbitrary sequence or script mode sessions is not allowed. 

• List mode control is disabled when InstrumentStudio is in monitor or controller 
mode. 

Note 

• Debugging features are not supported when using sweep mode in an 
SMU (Source Measure Unit) panel. 

• When monitoring a device in debug mode, InstrumentStudio 
establishes a connection to the device session in the external 
application, not the device itself. Therefore, InstrumentStudio will only 
monitor data that is fetched or read from the currently running external 
application. 
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• When InstrumentStudio is in controller mode, you cannot switch to list or sweep 
mode from another operation mode. 

• When InstrumentStudio is in monitor mode, you cannot take control of a panel 
with a mix of standard and arbitrary waveform channels. 

RF Signal Generator Debug Mode Limitations 

When using debug mode with an RF signal generator, be aware of the following 
limitations: 

• You cannot take control of an RF signal generator panel if streaming is enabled, or 
if there is an active configuration list. 

• You cannot return to script mode after clicking the Preset button. 
• Waveform-specific controls are read-only in Script mode. 

Related concepts: 

• Configuring Panels with the Instrument Header Menu 

Entering Debug Mode Entering Debug Mode 
You can enter debug mode from the Home screen by selecting Debug. Using this 
method, InstrumentStudio searches for open device driver sessions and then creates a 
layout based on the devices it discovers. The devices in the newly created layout 
automatically enter debug mode. 

You can also enter debug mode while an InstrumentStudio project is already open. A 
device in use by an external session automatically enters debug mode if debugging is 
enabled and the device is placed in a layout or is already part of an active layout. For 
example, if you are running an oscilloscope from InstrumentStudio and you run a 
LabVIEW application that acquires measurements from that oscilloscope, the 
InstrumentStudio panel containing the oscilloscope enters debug mode until the 
device's external session (in this case, the LabVIEW application) closes. 

Devices currently in use by an external application display the external session icon (
) in the Edit Layout window. 

Debugging Programmatic Applications

106 ni.com



Related tasks: 

• Enabling Debugging with a C, C++, or .NET Application 
• Disabling Debugging 

Enabling Debugging with a C, C++, or .NET Application Enabling Debugging with a C, C++, or .NET Application 
Complete the following steps to debug a C, C++, or .NET application using 
InstrumentStudio. 

1. Select Configure debug settings from the instrument header menu. 
2. Select the Using Breakpoints in C/C++/.NET Applications checkbox next to the 

device you want to debug. Click OK. 
InstrumentStudio enables breakpoints in C, C++, and .NET external applications. 

3. Debug the application and/or device. 
4. When you finish debugging, deselect the Using Breakpoints in C/C++/.NET 

Applications checkbox in the Configure Device Settings window and restart the 
external application to apply the changes. 

Refer to Monitoring and Controlling Devices in External Sessions for more information 
on using debug mode. 

Related concepts: 

• Entering Debug Mode 
• Configuring Panels with the Instrument Header Menu 

Note Debugging is enabled by default. If a device fails to enter debug mode, 
confirm that debugging is enabled by opening the Configure Debug Session 
window from the instrument header menu and checking the Debug Enabled 
box for the device you want to debug. If you change settings in the Configure 
Debug Session window while an external session is already open, you must 
restart the external session before changes will take effect. 

Note Supporting communication with a device in C, C++, or .NET 
environments at breakpoints requires additional overhead that may affect 
performance. 
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Monitoring and Controlling Devices Used in an External Monitoring and Controlling Devices Used in an External 
Session Session 
You must enter debug mode to access the Monitor and Control buttons. Refer to 
Entering Debug Mode for more information. 

Complete the following steps to monitor and/or control a device in InstrumentStudio 
when an external application is using the device: 

1. Select Monitor. 
InstrumentStudio obtains read-only access to the external session, and the 
device's controls are disabled. You are now monitoring the device. 

2. Select Control. 
InstrumentStudio takes control of the device if an external application is not 
currently accessing the device. If you select Control and you are not monitoring 
any external application sessions or the external application is paused, 
InstrumentStudio takes ownership of the device. 

3. Edit the device settings. 
4. Click Monitor to return to monitoring the session and revert control of the device 

to the external session. 
The edited device settings are applied to the external session. 

Live Measurement View Live Measurement View 
The following topic contains information about monitoring live device data in 
InstrumentStudio. 

Note Selecting Control takes control of the device only until the next 
time the external application calls the device, at which point control 
reverts to the external application and InstrumentStudio returns to 
monitoring the session. You can use breakpoints to pause the external 
application, allowing InstrumentStudio to retain control of the device 
until you have made your changes and you are ready to continue the 
application. 
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When monitoring a device in debug mode, certain devices will instantly display 
measurements of channel data, even if external applications are not fetching device 
data. InstrumentStudio currently supports live data monitoring for the following 
devices: 

• PXIe-4135 
• PXIe-4136 
• PXIe-4137 
• PXIe-4138 

• PXIe-4139 
• PXIe-4140 
• PXIe-4141 
• PXIe-4142 

• PXIe-4143 
• PXIe-4144 
• PXIe-4145 
• PXIe-4147 

Disabling Debugging Disabling Debugging 
Complete the following steps to disable debugging for a device: 

1. Open the Configure Debug Session window by selecting Configure debug session 
from the instrument header menu. 

2. Deselect the Debug Enabled checkbox to disable debugging for a specific device. 
3. Click OK. 
4. Restart the external application to apply the changes. 

Debugging is disabled for the specified device. This device cannot enter debug mode 
until debugging is enabled again. 
Related concepts: 

• Entering Debug Mode 

Note For devices not listed here, test code must call measure or fetch for 
measurements to be updated when in monitor mode. 

Debugging Programmatic Applications

© National Instruments 109



  Measurement Plug-Ins Measurement Plug-Ins 
Measurement plug-ins help you create reusable measurements for any supported 
device. A measurement plug-in consists of measurement logic and metadata 
generated in either Python or LabVIEW, and an optional UI. A measurement plug-in 
runs as a service. 

Refer to the Measurement Plug-Ins user manual for more information on 
developing measurement plug-ins. 

Related information: 

• Measurement Plug-Ins Python Examples 
• Measurement Plug-In User Manual 

Running a Measurement Plug-In 

Complete the following steps to run a measurement plug-in. 

1. Open the measurement in InstrumentStudio. 
2. On the Home screen, select Manual Layout. 

The Edit Layout screen appears. 
3. Locate your measurement plug-in in the list. Select Create large panel in the drop-

down list for your measurement plug-in. 

Note This feature is only available with an InstrumentStudio Professional 
license. 

Note If your measurement plug-in does not appear in the Edit Layout
window, ensure that the plug-in is either configured to start 
automatically or has been started manually. For more information, refer 
to Statically Register a Measurement Service section of 
Developing a Measurement Plug-In with LabVIEW or 
Developing a Measurement Plug-In with Python in the 
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The large panel updates to list the selected measurement plug-in. 
4. Click OK. 

InstrumentStudio opens a new project and displays the measurement UI. 
5. Optional: Ensure that the project contains any referenced pin map and that a pin 

map is marked as active. 
6. Click Run in the measurement UI. 

The measurement executes and values update in the measurement UI. 

Related information: 

• Measurement Plug-Ins Python Examples 

Plug-In Versioning 

Refer to the following section for details about using versioned measurement plug-ins. 

Versioned Plug-Ins 

Refer to Plug-In Versioning in the Measurement Plug-Ins user manual for 
information on versioning measurement plug-ins using LabVIEW or Python. 

Selecting A Measurement Plug-In Version 
When adding a measurement plug-in to your project layout in the Edit Layout or 
Manual Layout windows, use the version selector dropdown to select the version of 
the measurement plug-in you want to use. If there is only one available version of a 
plug-in, the version number will be displayed next to the plug-in. 

Measurement Plug-Ins user manual. 

Tip You can change the behavior of the Run button so that the 
measurement runs continuously. Click the arrow at the side of the button 
and select Run Continuously to change the button behavior. Once the 
measurement is running, the button text changes. Click Stop to stop the 
measurement. 
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Synchronizing Plug-In Versions within a Project 
To synchronize the plug-in version used by a measurement panel, open the panel 
settings ( ) and click Synchronize Version. This will update the panel to use the latest 
version of your measurement plug-in. 

Note Measurement plug-in versions will be automatically synchronized to 
match the version stored in your project. You can manually synchronize 
versions via the settings within your measurement panel ( ). Refer to the 
following section for more information on measurement plug-in 
synchronization. 

Note Version synchronization is only applied to the selected measurement 
panel. If multiple panels are using the same measurement plug-in, you must 
repeat this process for each panel you want to synchronize. 
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  Connecting to a Plug-In Library Connecting to a Plug-In Library 
A plug-in library is an HTTP web API that contains services you use to take 
measurements. Plug-in libraries enable you to share and collaborate across teams. 
Complete the following steps to connect to a plug-in library. 

1. Go to Edit Layout » Add remote host connections. 

2. Click the Add button. 
3. Select Plug-In Library as the Host type. 
4. Enter the IP address or hostname and the port number of the plug-in library you 

want to connect to. 
5. Click OK. 
6. Continue setting up your layout as needed. 

Once you have connected to a plug-in library, you can add measurement plug-ins to 
your InstrumentStudio project. Refer to Running a Measurement Plug-In for 
information on running measurements. 
Related concepts: 

• Measurement Plug-Ins 

Related information: 

• Plug-In Libraries 

Note You can add a plug-in library to your project using Edit Layout 
mode. 
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InstrumentStudio Plugins InstrumentStudio Plugins 
You can use InstrumentStudio to host plugins written in LabVIEW or C#. These plugins 
run alongside the InstrumentStudio panels used to configure PXI instruments. Plugins 
have a runtime configuration and an edit-time configuration. When exporting a plugin 
configuration to TestStand and using it in a step, the runtime configuration is provided 
to the sequence as a variable. Both of these configurations persist when the project 
containing them is saved. 

Support for Plugins 

The following limitations apply when hosting plugins in InstrumentStudio: 

• Hosting a plugin created in C# requires Visual Studio 2019 or newer and .NET 6.0. 
• Plugins built in older versions of InstrumentStudio (before version 22Q3) are no 

longer compatible and must be re-built. 
• Plugins cannot be created from the File » New menu. 
• You cannot use MeasurementStudio controls when hosting plugins created in C#. 
• When hosting a plugin in InstrumentStudio, you are limited to the following 

interactions: 
◦ Saving and loading 
◦ Resizing the window 
◦ Pulling out tabs 
◦ Exporting the session to TestStand 
◦ Stopping all outputs with LabVIEW plugins 
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Pin Maps Pin Maps 
Pin maps define test instruments and hardware, sites and pins connected to a DUT, 
and how the test instruments and hardware connect to DUT pins for each test site. 
InstrumentStudio preserves mappings created in TestStand Semiconductor Module 
(TSM) pin maps. 

Refer to the other topics in this section of the manual for specific information on how 
to use and modify pin maps in InstrumentStudio. 

Setting an Active Project Pin Map Setting an Active Project Pin Map 
Set an active pin map to filter your view of connected sites, pins, and devices within 
your test system in InstrumentStudio. 

1. Open your InstrumentStudio project. 
2. Decide how you want to add a pin map to your project. 

Option Description 

Create a new pin map Use the Pin Map Editor to create a new pin 
map for your project. 

Set a default pin map Automatically add a selected pin map to new 
InstrumentStudio projects and set it as the 
active pin map. 

Add a pin map file to your project files Select File » New » Pin Map to add a pin map 
file (.pinmap) to your project. 

3. Confirm that the pin map is valid. An error icon will appear next to the pin map file 

Note InstrumentStudio automatically sets the first pin map file you add 
as the active project pin map. The name of the active project pin map 
appears in bold in the project files pane. 

Note Only one pin map can be active within a project. 
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in the project files pane if InstrumentStudio detects a problem with it. Refer to Pin 
Map Errors and Warnings for more information. 

4. Activate the pin map. Right-click the pin map file in the project files pane and 
select Make active. 

5. Apply site filtering to view site pins in your panels. 
6. Apply pin filtering to view selected pins within a site in your panels. 

To deactivate the pin map, right-click the active pin map in the project files pane and 
select Make inactive. 

Selecting a Default Pin Map Selecting a Default Pin Map 
Choose a default pin map to add the selected pin map to all new projects created in 
InstrumentStudio. 

1. Go to File » Preferences » Pin and site mapping. 
2. Click the browse button to open the Default pin map file dialog and select a pin 

map file. 
3. To remove the default pin map preference, return to the Preferences menu, go to 

the Pin and site mapping section, and click the Clear button to remove the default 
pin map. 

InstrumentStudio will add the default pin map to project files when creating a new 
project, and automatically use the default pin map as the active project pin map. 

Creating a New Pin Map Creating a New Pin Map 
Use the Pin Map Editor to create new pin maps in InstrumentStudio. 

1. Select File » New » Pin Map or click Add in the project files pane toolbar to create a 
new pin map file (.pinmap). 

2. Use the Pin Map Editor to configure your pin mappings. The Pin Map tab displays 
mappable items. Use the left pane to browse through and configure the mappings 

Note When you launch InstrumentStudio within TestStand Semiconductor 
Module (TSM), InstrumentStudio automatically uses the pin map configured 
in TSM. 
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you want to include in your pin map. To manually edit the pin map file text, click 
the XML tab. 

3. Click OK to close the editor and return to your project. The new pin map is now the 
active project pin map. 

Adding Pin Map Files to a Project Adding Pin Map Files to a Project 
Add existing pin map files to your project to use pin maps you create outside of 
InstrumentStudio. 

1. Select File » New » Pin Map. 
2. Select a pin map file (.pinmap). 
3. Click OK to add the file to your project. 
4. Optional: To open the Pin Map Editor and update the pin map, double-click the file 

in the project files pane. 

InstrumentStudio will automatically make the first pin map file added to a project the 
active pin map for that project. To activate another pin map, right click it in the project 
files pane and select Make active. 

Editing a Pin Map Editing a Pin Map 
Use the Pin Map Editor to make changes to a project pin map. 

1. Double-click a pin map (.pinmap) in the project files pane to open the Pin Map 
Editor. 

2. Make the desired changes to your instruments, connections, and pins. Use the Pin 
map tab to view mappable items and change mappings. To manually change the 
pin map file, click the XML tab and to edit the pin map. 

When you have completed your edits, click OK to close the Pin Map Editor. 

Note If you are working in an unsaved project, InstrumentStudio will 
prompt you to save the project before creating a new pin map. 
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Using the Site Filter Using the Site Filter 
After setting an active pin map in InstrumentStudio, devices in your panel appear as 
pins grouped by sites, system pins, and unmapped channels. Use the site filter in the 
document toolbar to display pins from a selected site. 

1. In your instrument panel, click the site filter drop-down in the toolbar at the top of 
the document window. 

2. Select a site from the list to filter the view in the panel to the selected site. 

Related tasks: 

• Applying a Pin Filter 

• Exporting an InstrumentStudio Configuration 
• Applying a Pin Filter 

Applying a Pin Filter Applying a Pin Filter 

Use a pin filter to select site and system pins to view in an instrument panel. 

Before applying pin filtering, you must select an active project pin map. 
Pin maps often contain many pins. Pin filtering enables you to view selected pins to 
improve navigating within a panel. 

Note 

• You must select All sites in the site filter to view unmapped channels. 
Site filtering does not apply to RF signal generators because each 
device channel can be mapped to multiple pins on multiple sites. You 
must select sites and pins in the RF signal generator panel settings ( ). 

Note You cannot export an InstrumentStudio configuration to TestStand 
while the site filter is set to "All sites". Select a specific site in the site filter, or 
select "System pins" to only export system pins. 
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1. Click the pin filter button ( ) within your device or instrument panel. 
2. Enable the pins you want to view in your panel. 
3. Click OK. 

Your panels will now display configuration settings for pins selected in the pin filter, 
and measurement panels will display measurements for those pins. Information about 
hidden and non-idle pins appears underneath the Pins section of the panel. 

Related tasks: 

• Using the Site Filter 

Pin Map Errors and Warnings Pin Map Errors and Warnings 
InstrumentStudio highlights errors and warnings in project pin map files (.pinmap). 

Error and Warning Behavior 

Common causes of pin map errors and warnings include improperly formatted pin 
map files, and pin map settings that do not correspond to configurations within your 
test system. 

To determine the cause of the error, double-click the pin map file to open the Pin Map 
Editor. The dialog will display a message with specific information about the cause of 
the error or warning. Refer to the following table for information on pin map errors and 
warnings. 

Notification 
Type Expected Behavior 

Error Panels will not work using the selected pin map. InstrumentStudio reverts to using 
the default instrument and channel views. You must address the error before using 

Note Non-idle pins are pins that are not visible within the filtered view, but 
are still active. 

Note The pin filter state is saved in the instrument panel, and will be 
restored when the panel is re-opened. 
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Notification 
Type Expected Behavior 

the pin map file. 

Warning 
You can use the pin map, but errors may occur at run time. Determine the source of 
the warning and make the necessary corrections using the Pin Map Editor before run 
time. 

For detailed information on pin map files, refer to Pin Map XML File Structure. 
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Enabling Preview Features Enabling Preview Features 
Preview features are new features in InstrumentStudio that support specific 
workflows. They are not release-quality features, and may have functionality gaps. 
They are only supported for specific uses. You must enable preview features in the 
InstrumentStudio settings menu to use them. 

Follow the steps below to enable preview features. 

1. Go to File » Preferences » Preview Features. 
2. Click the toggle to enable the desired preview features. 
3. Close the Preferences panel. 

Once you have selected the preview features you want to enable, you must restart 
InstrumentStudio. 

© 2025 National Instruments Corporation. 
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